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Cel Editor Tools Window

The Tools window is located, by default, at the left edge of the Cel Editor window.
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Cel Editor Actor Player Window

The Actor Player window is located by default at the bottom right edge of the Cel Editor 
window.
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Background Editor Tools Window

The Tools window is located, by default, at the left edge of the Background Editor window.
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Basic Concepts: Overview
Animation is a three-step process. First you create the actors, then you create the 
backgrounds, and finally, you assemble both into a movie. Animation Works Interactive 
supplies environments and tools for each of these steps.
The animated characters, or actors are created in individual, incremental images, called 
cels. If all the cels of an actor, for example a walking man, were painted on cards and laid 
out on a table, they would resemble a series of snapshots of the character's movement. 
Stacking the cards and flipping through them quickly would create the illusion of motion.
After the actors have been created, you then create the backgrounds. These are the pictures
that form the backdrop for the scenes in your movie. Backgrounds may be larger than the 
actual frame size of your movie; this allows you to scroll through the backgrounds, giving the
illusion of travel.
Once the actors and backgrounds have been created, they must be assembled into a movie.
Movies consist of frames. Each frame consists of a background with actors in front of the 
background. The actors move along paths which start at a particular frame and end at some 
later frame. A path is the curve drawn through the positions of a specific actor in each 
frame. For example, if a man moves in a straight line from the left edge of the screen to the 
right edge over 20 frames, his path would be a line consisting of 20 points, each 
representing his position in a particular frame. The movie can contain an unlimited number 
of paths, and paths can move in front of or behind other paths.
Finally, effects such as sound may be added at any point within the scene.
Animation Works Interactive provides the three environments where you create the 
actors, the backgrounds, and assemble them into movies. The three environments are called
the Cel Editor, the Background Editor, and the Movie Editor, respectively. You can move 
between these environments as often as you like.



Basic Concepts: The Movie Editor
The Movie Editor is the heart of Animation Works Interactive. The highly interactive 
nature of the Movie Editor allows you to view your movies, while you are creating them, as 
they would finally appear.If you were creating a movie by hand, you would start with a 
painted background. Stacks of cels painted on a clear plastic would be available to you, each
stack representing an actor in the movie. You would create the first frame of your movie by 
overlaying a single cel from each stack, with the background showing through the clear 
plastic. You would then photograph the resulting image. For the next frame, you would again
start with the painted background (perhaps offsetting it, if the background is scrolling) and 
overlay it with the next cel from each stack. You may shift the cel relative to its position in 
the previous frame if the actor is moving over the background. You would continue in this 
fashion for each frame in your movie; a tedious but inherently simple operation.
The Movie Editor works in a similar fashion, except that you create the motion of each actor 
completely before starting the next. For example, if you wanted a dog to run across your 
background, chased by a cat, you would first create a path for your dog actor by drawing a 
line from the left edge of your screen to the right. You would then specify the number of 
frames over which the dog runs across the screen. The fewer the number of frames, the 
faster the dog would seem to run (since you "flip" through 10 frames more quickly than 
through 20). The Movie Editor automatically creates the required number of frames, 
duplicating the background in each frame, cycling through the cels from the dog actor, and 
overlaying each cel, slightly shifted from its position in the previous frame. This process 
simulates motion.
To add the cat's path, you would then step through the movie to the point at which the cat 
would logically enter the scene, and then repeat the above process. When you create the 
cat's path, the cat is automatically forced in front of all other actors in this frame. This can 
be changed later if you change your mind. With the Movie Editor, you get constant feedback.
The dog is still visible as you create the cat's path. When adding to your movies, you always 
see what you have previously created, making animation almost as simple as moving the 
mouse and clicking.
This concept of creating paths parallels that of a multitrack studio used in the music 
industry. A single musician can play several instruments in a song by recording the sound of 
each instrument as a separate track and then overlaying the tracks using a "mixer". The 
Movie Editor is essentially a mixer that allows you to create several paths and overlay them 
to create movies.



Basic Concepts: The Movie Editor Paths
Paths are central to Animation Works Interactive. They determine:
- where an actor should appear in each frame
- which cel of the actor is displayed in the frame
- whether the actor appears in front of, or behind, other actors
Each path is associated with an actor. However, the same actor can appear in multiple 
paths. Hence, if you want to create an animation of a flock of birds, you only need one bird 
actor.
The Movie Editor provides a variety of tools for creating paths. Tools such as line, arc, free 
hand, and polygon allow you to create regular shaped paths quickly and easily. For more 
complex motion, such as people walking, the Registered Motion tool allows you to create 
paths a frame at a time.
In addition to creating paths, the Movie Editor also includes tools you can use to modify 
existing paths. Entire paths or portions may be repositioned by simply clicking and dragging 
the mouse.



Basic Concepts: The Movie Editor Events
While paths exist across many frames, "Events" are attached to specific frames and initiate 
an action. There is no limit to the number of events that can occur within a movie. Some of 
the more important events available in the Movie Editor are:
Background
A Background event changes the background in the movie from the specified frame until 
another Background event occurs.
Wipe
This event is only available on a frame that has a Background event. The Wipe event allows 
you to create special transitions to introduce the new background.
Timing
The speed at which your movie plays is determined by the frame speed. For example, a 100-
frame movie playing at 10 frames per second will last 10 seconds. The same movie playing 
at five frames per second will last 20 seconds. The Timing event allows you to vary the 
frame speed at any point in the movie. The new frame speed stays in effect until the next 
Timing event or the end of the movie.
Sound
One of the most compelling effects you can add to an animation is sound. Sound clips in \
KWAV\k, MIDI or Compact Disc formats can be added to a movie starting at any frame. Most 
often, you would record a sound, time it, and coordinate the animation to the duration of the
sound. At other times, you would create the animation first, and record the sound to fit. 
Either way, sound adds an extra dimension to your movie.
Loop
A Loop event allows you to repeat any portion of your movie a specified number of times.

In addition to the above list of events, other Animation Works Interactive events allow 
you to add interactivity to your movie (a separate section in Basic Concepts), scroll your 
backgrounds horizontally or vertically, attach names to specific frames, change the color 
palette of a movie, or freeze the playback at any time for any duration.



Basic Concepts: The Movie Editor Interaction
This advanced feature allows you to map mouse or keyboard sequences so that you can 
interact with your movies. This feature is very useful in making presentations. You can map 
the right mouse button, for example, such that while your movie is playing, clicking this 
button pauses the movie, plays a sound, or moves to another section of the movie.



Basic Concepts: The Cel Editor
The Cel Editor allows you to create cels, and group them into actors. The Cel Editor offers 
the same paint tools as the Background Editor. Its special function, however, is to help you 
create sequences of incrementally different images. Playing theses cels together and in 
sequence gives the effect of animation.



Basic Concepts: The Cel Editor Onion Skin
Professional animators draw their actors on tracing paper. This enables them to see the 
previous images (the previous cel) while they are drawing the current one, thus ensuring 
that the movement is smooth from one cel to the next. This process is called "onion 
skinning".
The Cel Editor includes the option of an onion skin. When turned on, the onion skin displays 
a faint image of the previous or next cel on top of which you can draw the current cel. You 
can compare the changes in one image to the one before it, ensuring accurate work. For 
example, you can draw a character's body and use onion skin to accurately redraw the arms 
and legs to produce a walking effect.



Basic Concepts: The Cel Editor Registration
An important concept in animation is that of registration. Consider the example of a walking 
man painted on cards. Flipping through these cards will produce a smooth animation only if 
all the cards are correctly aligned or registered. Flip books used in the past worked well 
because all their pages were bound on one side and hence kept in alignment.
To ensure registration you first specify a point on each cel as the registration point. You then 
position the cels such that the registration points are on top of each other. The cels are now 
said to be in register. The trick behind correct registration is selecting appropriate 
registration points. In general, the point chosen on the actor should remain stationary 
throughout the actor's movement. In the walking man, for example, the tip of the foot that is
on the ground remains stationary throughout the movement; otherwise, the actor would 
appear to be sliding.
The Cel Editor provides the tools for setting the registration points and also for automatically
aligning, or registering, all cels in the actor.



Basic Concepts: The Cel Editor Transparent Color
The Transparent Color option of the Cel Editor is another tool provided by Animation Works
Interactive to help you make realistic movies.
Before we discuss transparent colors, let us first describe the two basic types of colors found
in a movie; these are foreground and background colors. When you create an actor, or 
modify an existing one, it usually has a color. The color of the actor in a movie is called the 
foreground color. When you bring the actor into the Movie Editor, you select a color for the 
background; this is called the background color. The background for your movies can be a 
color, a bitmap or a gradient (a combination of colors).
If you create a movie which consists of a red car travelling along a coastal highway, the 
foreground color will be red and the background color will be blue.
To understand the idea of transparent colors, consider the following scenario:
Suppose you want to make a movie of a red car with white windows travelling along a 
coastal highway. You load the actor (a bitmap file) into the Cel Editor and create cels to 
animate the car. You then go to the Movie Editor and draw a path for your actor. You select a 
blue background (blue water) for the actor's path. If you play this movie, you will notice that 
you can't see the water (blue background color) through the red body of the car; this is 
natural. You should be able to see the water (blue background color) through the windows of
the car as it moves along the road; but that is not happening.
To achieve the realistic effect, you have to make the color of the windows in each cel of the 
actor transparent so that the windows are transparent throughout the movie. To create a cel 
so that it's background is transparent in the movie, you would choose a color for its 
background that does not appear on the actor as the cel's transparent color (white in this 
example).
If you now play this movie, the water will be visible through the car windows as the car 
travels along the road. 



Basic Concepts: The Background Editor
The Background Editor is a 256-color paint program. The Background Editor reads GIF, DIB 
and BMP files and writes DIB bitmap files. This means that you can create background 
images using any other paint program that supports one of the above formats and import 
the images into Animation Works Interactive to use as backgrounds for your movies. You 
can also scan images from other programs and use them as backgrounds in your movies.
Your Animation Works Interactive backgrounds can be of one of the following types:
- Bitmap
- Solid
- Gradient (created from a specified color palette)







Movie Editor Tools Window: Selection Tool
The Selection tool is used for selecting and moving paths and path nodes in the Movie 
Editor.
Paths represent the motion of an actor through the frames of the movie. Paths determine 
where the actor appears in each frame, which cel of the actor is displayed in the frame and 
whether the actor should be in front of, or behind, another actor in the frame.
A path is represented by a line with several points, called nodes, along it. These nodes 
represent the instance of the actor in each frame. The current node is the instance of the 
actor in the current frame and is shown by the appropriate cel image of the actor.
To select a path simply click the left mouse button once on the path's actor and the path 
becomes visible. Actors in the frame are shown with a dotted-line border around them when 
Options/Borders is selected.
The Selection tool can be used for the following:
- To redisplay the Adjust Path dialog - use the selection tool and double click the image of 
the actor. This will allow you to change the number of frames in a path, or the acceleration 
or deceleration.
- To change the Cel Sequence of a path - hold down the Shift key and double click the actor 
on screen. This will display the Cel Sequence dialog. Since Text Actors consist of only one cel
holding the Shift key and double clicking a text actor on screen will bring up a text edit box 
with the text of the current actor in it.
- To move the entire path to another location on screen - click on the image of the actor and 
drag the path to the new location. To constrain this movement to be only horizontal or 
vertical, hold down the Shift key while moving the path. While moving paths, using the 
ctrl+arrow keys will move the cursor and the attached path one pixel in the direction of the 
arrow.
- To change the position of the selected actor in the current frame - hold down the spacebar 
and click and drag the actor's image to the new position. Holding down the Shift key while 
moving the actor's image will constrain the movement to be only horizontal or vertical. 
While moving the actor, using the ctrl+arrow keys will move the cursor and attached actor 
one pixel in the direction of the arrow.
- To change the cel image of the selected actor to another in its cel sequence - hold down 
the Shift key and press the left or right arrow keys. The Shift + Left arrow key sequence 
cycles backwards through the cels of the actor, while the Shift + Right arrow key sequence 
cycles forwards.
- To change the position of any node along an actor's path - hold the mouse button down 
while the pointer is over the node and drag. Holding down the Shift key while moving the 
node will constrain the movement to be only horizontal or vertical. While moving the node, 
using the ctrl+arrow keys will move the cursor and attached node one pixel in the direction 
of the arrow.
You will notice that the cursor changes to four arrows pointing inward when your cursor is 
over a node. When you click to begin dragging the node, the cursor will change to four 
arrows pointing out.



Movie Editor Tools Window: QuickText Tool
This tool allows you to create text actors.
Selecting the Quick Text tool displays a text editing box where you can enter and edit text.
Use the Attributes menu item in the Text menu to customize your text.
To resize the text edit box, position the pointer over any of the borders of the box and drag it
to the desired size.
To move the text edit box, position the pointer over the title bar at the top of the window 
and drag.
After entering the desired text, click on the Selection tool, or press the Esc key, to close the 
text box.
You will be asked to name the text actor. The default name of the actor is the first line of 
text in the text editing box.
The text is placed into memory as an actor, and is displayed in the Actor window. This allows
you to immediately start using one of the path tools to place the Quick Text actor into your 
movie.
Quick Text actors are placed into movies just like all other actors.



Movie Editor Tools Window: Registered Motion Tool
The Registered Motion tool allows you to create a path by clicking at points in the Movie 
Editor's window (stage).
When you select this tool the actor shown in the Actor window is attached to the cursor.
With each click on the screen, one cel of the actor is placed into the movie on the current 
frame. The movie automatically advances to the next frame.
Clicking on the screen five times, for example, creates a path placing five cels of the actor 
into five frames of the movie; i.e., one cel in each of the five frames.
Each time you click the mouse button, the actor advances to the next or previous cel in its 
cel sequence. The direction of the advance is set by the Options/Cel Sequence command. 
The cels of the actor are cycled through as you continue clicking the mouse button.
To end creating a path, click on the Selection tool or press the Esc key. A path will then be 
created joining the individual cels that you have positioned.
If, while creating the path, you want to change the current cel that is attached to the cursor,
hold down the Shift key and press the left or right arrow key. The Shift + Left arrow key 
sequence cycles you backward through the previous cels of the actor. The Shift +Right 
arrow key sequence cycles you forward through the next cels of the actor.



Movie Editor Tools Window: Path Tools Icon
Clicking and holding the mouse button on this icon displays a window with six other icons 
(tools) from which to choose.
To select one of the path tools, hold the mouse button down while you drag over the desired 
tool button. The tool buttons will depress as you drag over them. Release the mouse button 
when the desired tool button is depressed.
The path tools allow you to place an actor into a movie along a path. A path is an actor's 
course of action. It tells the actor where to be on each frame of the movie. 
All the path tools, when selected, use the actor shown in the Actor window.
Depending on the path tool you have chosen, you either draw out the path, or set the start 
position. (See the section on the individual path tools below for more information about 
drawing and setting starting points.)
Once the path has been drawn the Adjust Path dialog box is displayed. Set the number of 
frames it will take the actor to get from the beginning to the end of the path. Adjusting the 
"in-betweening" for the movement of the actor across the screen is achieved by setting the 
number of frames for the path.
In-betweening refers to the distance the actor travels across the screen from one frame to 
the next. If this distance is too great (i.e., the number of frames specified is too low) the 
actor appears to jump across the screen instead of moving smoothly. If the in-between 
distance is too small (i.e., the number of frames is too high) the actor may take too much 
time to get from its starting position to its ending position. You must often compromise 
between smoothness of motion and speed of travel.
The Adjust Path dialog box also enables you to set an acceleration and deceleration factor 
for the beginning and end of the path. See the section on Adjust Path, for more information 
on Acceleration and Deceleration.
The choice of which cel of the actor is shown in each frame of the movie is determined by 
the Cel Sequence Mode item of the Options menu. The choices for cel direction are: forward,
reverse, ping-pong, and still frame.



Movie Editor Tools Window: Straight Line Path Tool
This tool creates a straight line path.
Hold down the mouse button and drag the mouse to draw the line.
Holding down the Shift key while dragging out the line constrains the line to horizontal, 
vertical, or 45-degree angle directions. 
Using the ctrl+arrow keys, while the actor is attached to your cursor or while dragging out 
the path, will move the cursor and actor one pixel in the direction of the arrow.
After releasing the mouse button the Adjust Path dialog box is displayed.



Movie Editor Tools Window: Freehand Path Tool
This tool animates an actor along a freely drawn path.
Position the cursor where you want the path to start. 
Hold down the mouse button and drag around the stage.
Release the mouse button to complete the path.
After releasing the mouse button, the Adjust Path dialog box is displayed.



Movie Editor Tools Window: Curved Path Tool
This tool creates a circular arc path.
Drag the mouse with the left button pressed to define the size and shape of the oval or 
circle that contains the desired arc.
Holding down the Shift key while dragging out the oval constrains it to a circle.
Using the ctrl+arrow keys, while the actor is attached to your cursor or while dragging out 
the path, will move the cursor and actor one pixel in the direction of the arrow.
Release the mouse button when the desired oval or circle has been drawn.
The next step is to select the segment of the oval or circle that you want your actor to 
follow.
As you move the pointer around the stage you will see a line extending from the center of 
the oval or circle to the cursor.
Position the pointer so that the line is at the starting point of the desired segment.
Hold the mouse button down and drag in the direction of your path. The segment is drawn 
on your screen as you drag the mouse.
Holding down the Shift key while dragging out the segment constrains the segment to 45-
degree angles or multiples of 1/8th of the oval or circle.
When you are finished dragging out the desired segment, release the mouse button.
The Adjust Path dialog box is displayed.



Movie Editor Tools Window: Polygon Path Tool
This tool animates an actor along a polygonal path.
Click at different points in the Movie Editor's window (stage).
Each point is joined to the previous one by a straight line.
Holding down the Shift key constrains the current line segment to 45-degree angles.
Using the ctrl+arrow keys, while the actor is attached to your cursor or while dragging out 
the path, will move the cursor and actor one pixel in the direction of the arrow.
To end the path, double-click the mouse button.
The Adjust Path dialog box is displayed.



Movie Editor Tools Window: Gravity Path Tool
This tool creates paths for gravitationally correct motion.
Click the mouse button at the start location, and drag to draw a line in the direction you 
want the object to travel. The length of the line doesn't matter. Animation Works 
Interactive only uses the direction of the line to calculate the effects of gravity.
The Gravity Path dialog box is then displayed. You can set a variety of parameters:
You are required to specify the number of frames in the path. This is because you will not be 
prompted with the Adjust Path dialog box when using the Gravity Path tool.
The G-Force option specifies the strength of the gravitational field. The higher the value, the 
faster the acceleration. 
The Initial Speed option specifies the speed with which the actor moves along the line drawn
previously. A negative value will have the actor moving in the opposite direction to the line.
The Damping option allows you to simulate the effects of air resistance. Whereas the actor 
speeds up due to gravity, damping tends to slow it down.
The Horizontal and Vertical buttons designate the direction of the gravitational force.
The Reflect on Crossover option allows you to specify whether you want the actor to 
"bounce back" when it hits the gravity line.
The % Energy Loss on Reflection option designates the percentage of energy (speed) the 
actor looses on each bounce.
You can specify the position of the gravity line by clicking on the Reset Earth button and 
then clicking on a new location on the screen.
Click on the Apply button to update the screen with the changes specified in this dialog box.
Click on the OK button when you have finished setting the options. Animation Works 
Interactive will automatically create a gravity-guided path.



Movie Editor Tools Window: Text Transition Path Tool
This tool is used to add text to your movie using transitions to bring the text on screen, and 
to move the text off screen. This tool is only available when you have a text actor visible in 
the Actor window. After clicking on this tool, the text will be attached to your cursor. 
Move the text to the position on screen where you want the text to be displayed. Click the 
mouse button to set the display point. The Text Path Transition dialog box will be displayed. 
This dialog is used to tell Animation Works Interactive how to move the text to and from 
the point that you have selected on screen.
In this dialog you must specify the number of frames for the text actor to be visible on 
screen. Enter this number in the Number of Frames edit box.
Two transition options are available. The first is an Entry Transition. This is the transition 
used to move text onto the screen. The second is the Exit Transition. This is the transition 
used to move text off the screen. If you entered 100 in the Number of Frames edit box and 
had no Entry or Exit transition, the text would remain motionless on screen for 100 frames.
The Entry Transition group box allows you to specify the number of frames for the Entry 
Transition to take, as well as the direction of entry and the type of transition. Enter the 
number of frames in the edit box to specify the number of frames to use for the Entry 
Transition. This number must be less than the number of frames for the path. Use the drop 
down list to select the type of transition you desire, and the direction in which the motion is 
to occur.
The Exit Transition group box is the same as the Entry Transition group box except that it 
specifies the transition, number of frames, and direction for the text to leave the screen. The
number of frames in the Entry Transition box added to the number of frames in the Exit 
Transition box must not exceed the total number of frames in the path. 
Click on OK to add these transitions to your text actor path.
To edit these transitions select Path/Text Transition to redisplay the Text Path Transition 
dialog box.



Movie Editor Tools Window: Insert Path Node After Tool
This tool places you in insert mode, allowing you to insert path nodes after the current 
frame of the selected path.
After clicking on the Insert Path Node After icon, you select the path tool to use for inserting 
by clicking on the path tool's icon.
While in insert mode, you can use any of the path tools by simply selecting one of them. 
This allows you to combine path effects. For example, you can start with a straight line, add 
a curved line, and then add a freehand path.
After creating each portion of a path with a path tool, the Adjust Path dialog box is displayed
and you can specify the number of frames that segment of the path is to have. Clicking on 
the OK button in the Adjust Path dialog returns you to the Registered Motion tool mode 
where you can continue inserting path nodes.
Click on the Selection tool to finish inserting path nodes.



Movie Editor Tools Window: Insert Path Node Before Tool
This tool places you in insert mode, allowing you to insert path nodes before the current 
frame of the selected path.
After clicking on the Insert Path Node Before icon, you select the path tool to use for 
inserting by clicking on the path tool's icon.
While in insert mode, you can use any of the path tools by simply selecting one of them. 
This allows you to combine path effects. For example, you can start with a straight line, add 
a curved line, and then add a freehand path.
After creating each portion of a path with a path tool, the Adjust Path dialog box is displayed
and you can specify the number of frames that segment of the path is to have. Clicking on 
the OK button in the Adjust Path dialog returns you to the Registered Motion tool mode 
where you can continue inserting path nodes.
Click on the Selection tool to finish inserting path nodes.



Movie Editor Tools Window: Path To Front Tool
This option moves the selected path or part of the path one or more layers to the front. The 
following options are available with this tool:
Clicking on the Path To Front icon moves the entire path one layer closer to the front.
Double clicking on the Path to Front icon moves the entire path to the foremost layer.
Holding down the Shift key and clicking on the Path To Front icon moves the current node 
one layer closer to the front.
Holding down the Shift key and double clicking on the Path To Front icon moves the current 
node to the foremost layer.
Holding down the Ctrl key and clicking on the Path To Front icon moves the first node of the 
path to the current node one layer closer to the front.
Holding down the Ctrl key and double clicking on the Path To Front icon moves the first node 
of the path to the current node to the foremost layer.
Holding down the Alt key and clicking on the Path To Front icon moves the current node to 
the end of the path one layer closer to the front.
Holding down the Alt key and double clicking on the Path To Front icon moves the current 
node to the end of the path to the foremost layer.



Movie Editor Tools Window: Path To Back Tool
This tool pushes the selected path or part of a path one or more layers to the back. The 
following options are available with this tool:
Clicking on the Path To Back icon moves the entire path one layer to the back.
Double clicking on the Path To Back icon moves the entire path to the rearmost layer.
Holding down the Shift key and clicking on the Path To Back icon moves the current node 
one layer closer to the back.
Holding down the Shift key and double clicking on the Path To Back icon moves the current 
node to the rearmost layer.
Holding down the Ctrl key and clicking on the Path To Back icon moves the first node of the 
path to the current node one layer closer to the rearmost layer.
Holding down the Ctrl key and double clicking on the Path To Back icon moves the first node 
of the path to the current node to the rearmost layer.
Holding down the Alt key and clicking on the Path To Back icon moves the current node to 
the end of the path one layer to the back.
Holding down the Alt key and double clicking on the Path To Back icon moves the current 
node to the end of the path to the rearmost layer.



Movie Editor Player Window: First Frame
Clicking on this button rewinds your movie to its first frame.



Movie Editor Player Window: Previous Frame
Clicking on this button rewinds the movie one frame.



Movie Editor Player Window: Play Backward
Clicking on this button plays the movie backwards starting at the current frame. Note that 
only video events will be played backwards; sound events, for example, will not be played in
reverse.



Movie Editor Player Window: Play Forward
Clicking on this button plays the movie in the forward direction.



Movie Editor Player Window: Next Frame
Clicking on this button advances the movie one frame.



Movie Editor Player Window: Last Frame
Clicking on this button advances the movie to the last frame.



Movie Editor Player Window: Play To End/Continuous
Clicking on this button toggles between Play to End and Continuous Play. This feature takes 
effect in both the Movie Editor and Full Screen Play environments and for both forward and 
backward play.
When Play to End is selected and the movie is played in the forward direction, the movie 
plays to the last frame and stops.
When the movie is played in the reverse direction the movie plays to the first frame and 
stops.
When Continuous Play is selected and the movie is played in the forward direction, the 
movie plays to the last frame and then starts playing over from the beginning. This 
continues indefinitely until the movie is stopped. 
When playing the movie backwards, the movie plays backwards to the first frame and then 
continues playing backwards from the last frame. This continues indefinitely until the movie 
is stopped.
A movie is stopped when the user presses the Esc key.



Movie Editor Player Window: Full Screen Play/Movie Editor 
Play
Clicking on this button toggles between playing the movie in the Movie Editor Play 
environment or in the Full Screen Play environment.
In the Movie Editor Play environment, the movie plays within the editor's window. All the 
tools and player controls remain visible while the movie is playing.
This is often used in editing, where it is useful to see controls such as the frame counter, 
while the movie is playing.
In Full Screen Play mode, the entire screen is filled with the animation. Windows, window 
borders, the menu bar, and anything else will be hidden. 
Animations may run faster in this mode than in the Movie Editor Play mode. This is also the 
mode you would use when presenting your movie.



Movie Editor Player Window: Frame Scroll Bar
This scroll bar reflects the frames of the entire animation. The number in the box on the 
scroll bar (called the Frame Counter box) is the frame number of the current frame.
Dragging the Frame Counter box along the scroll bar allows you to scroll through the frames 
of your movie. Holding down the Ctrl key while dragging the Frame Counter box prevents 
the frame from updating until you release the mouse button.
The Frame Scroll Bar is a percentage bar; clicking in the middle of the bar takes you to the 
middle of the movie, clicking three quarters of the way along the scroll bar takes you three 
quarters of the way through your movie. The Frame Counter box will move to the spot that 
you clicked on the scroll bar. 



Movie Editor Actor Window: Actor List Icon
Click on the down arrow at the top of the Actor window to display a drop down list with the 
names of all actors currently loaded into memory.
Click on the desired actor's name in list.
The selected actor will now be displayed in the preview area. You can animate the actor in 
the preview area by clicking on the Play/Pause button at the bottom right corner of the Actor
window.



Movie Editor Actor Window: Disk Icon
Clicking on the Disk icon displays the Open Actor dialog box, allowing you to retrieve any 
actor from disk.
Select the actor file you wish to load, then click on the Open button.



Movie Editor Actor Window: Trash Icon
Clicking on the Trash icon deletes the selected actor from memory. 
A warning is displayed if you attempt to delete an actor that is being used in the movie.



Movie Editor Actor Window: Play/Pause Actor Preview Icon
This button toggles the previewing of the current actor in the actor window. When playing, 
the current actor is previewed in the actor window. When paused, the current actor is only 
shown frozen in the actor window.



Movie Editor Menus: File Menu
The commands under the File menu allow you to start a new movie, open an existing movie,
insert a movie into another, save a movie or a frame of a movie, reload a previously saved 
movie, and exit Animation Works Interactive.



Movie Editor Menus: File New
This command creates a new untitled movie of one frame for you to work with.
A Purge Resources dialog box will appear if there are any resources currently loaded. 
Resources are backgrounds, actors, etc., that reside in memory. Choosing to purge the 
resources will release them from memory.



Movie Editor Menus: File Open
This command displays the Open Movie dialog box which allows you to select a movie from 
disk.
A Purge Resources dialog box may appear. Resources are backgrounds, actors, etc that 
resides in memory. Selecting to purge the resources will release them from memory.



Movie Editor Menus: File Insert
This command allows you to insert a movie saved on disk into the current movie. Selecting 
this command displays the Insert Movie dialog box. Options for inserting movies are:
- Insert before current frame
Inserts the new movie before the current frame.
- Insert after current frame
Inserts the new movie after the current frame.
- Overlap movie
Inserts the paths of the new movie on top of the current movie starting at the current frame.
The events of the new movie are not used.
Clicking on OK displays the standard file dialog allowing you to select the movie you want to
insert from disk.
When using the insert before or insert after options, the new movie uses its own set of 
events. When the new movie ends, you have the option of either keeping those events in 
effect as the original movie begins playing again, or reverting back to the events that were 
in use before the new movie started.
To revert to the original events:
Click on the "Restore original events when done" option.
If you select the overlap option, the palettes from the current movie are used for both 
movies. As the new movie is loaded, you will have the option to remap the actors of the new
movie to the current palette of the current movie. Choosing to remap the actors will make 
them look as similar to the original palette as possible.



Movie Editor Menus: File Save
This command saves the current movie as a non-embedded file. This saves the movie under
the filename last selected in the Save As dialog box; the version on disk is overwritten. 
If the movie has not been previously saved, choosing the Save command prompts you with 
the Save Movie As dialog box. You can name the movie and select the directory where you 
want the movie saved. (See Save As for an explanation of the other available options in the 
Save As dialog.).
When using the Save command, elements such as actors, backgrounds and sounds are not 
saved with the movie; instead, the movie simply stores the name of the file it needs and all 
relevant information about paths and event structures.
In cases where a number of movies are all using the same actors, significant savings in disk 
space can be achieved by saving your movies in a non-embedded format.
Any actors or backgrounds not saved as individual movie components are automatically 
embedded in the movie when you choose the Save command. (See Save in the Cel Editor 
section of this chapter for more information on saving the individual components of movies.)



Movie Editor Menus: File Save As
This command displays the Save Movie As dialog box which allows you to specify a new 
name for the copy of the movie you want to save and the location you want to save it in.
The Save As command allows you to save your movie in one of two formats:
Save Non-embedded
(the Embedded feature on the Save Movie As dialog box is turned off)
Generally, Save Non-embedded saves only the path and event structures of the movie. Only
the filenames of the actors, backgrounds, and sounds are saved, resulting in smaller file 
sizes. However, those actors and backgrounds that were created during the session and 
were not saved on disk, are also saved with the movie.
Saving actors and backgrounds individually and using them as shared components in a 
number of movies is the recommended method of saving under normal circumstances. This 
method results in the efficient use of disk space.
Save Embedded
Saves a copy of the movie with all the components the movie requires; all the actors, 
backgrounds, sounds, paths, events, etc. are embedded in the movie.
This is useful for movies that you intend to distribute or transfer to another machine. Save 
Embedded saves everything relevant to the movie in one file. The only exceptions are 
Compact Disk sounds and MIDI data.
Using the Embedded option to save a copy of the movie resets the Save command so that 
the next time the Save command is selected, you will be prompted with the Save Movie As 
dialog box. This prevents the embedded movie from accidentally being overwritten by the 
Save command. The Save command always uses the default non-embedded format.
Compressed
You also have the option of turning on image compression. This will save the files in an RLE 
compressed format which decreases load and save times as well as reduce the amount of 
disk space used.
Note
Some types of video drivers cause the images to be compressed incorrectly. If your images 
are not correct when reloaded after being saved in the compressed format, avoid using this 
option. You may want to contact the video manufacturer and request an updated driver.



Movie Editor Menus: File Create Backup
The File/Save command normally writes over the older version of the movie you are saving. 
If the Create Backup menu option is turned on, Animation Works Interactive will first 
rename the original movie to have the filename extension .BAK. When this option is on, 
twice as much disk space will be used, because two copies of the movie will be present on 
disk (the current version and the previous version).



Movie Editor Menus: File Revert to Saved
This command reloads from disk the most recently saved version of the movie you are 
working on. Any changes made to the movie since it was last saved will not be retained.
If the movie has never been previously saved, this option is unavailable.
The Revert to Saved command is useful when you are unhappy with the results of changes 
made to an animation since it was last saved and would like to go back to the previous 
version.



Movie Editor Menus: File Save Frame
This command allows you to save the current frame as a bitmap file (with the filename 
extension .DIB). Selecting this command displays the Save Frame dialog box. Specify a 
name in the Filename edit box.



Movie Editor Menus: File Exit All AWI Editors
This command will close down all of the Animation Works Interactive editors which are 
currently running.
If there are any changes not previously saved, you are prompted to save them before you 
exit Animation Works Interactive.



Movie Editor Menus: File Exit AWI Movie Editor
This command exits the Animation Works Interactive Movie Editor.
If there are any changes not previously saved, you are prompted to save them before you 
exit the Movie Editor.



Movie Editor Menus: Edit Menu
Although Animation Works Interactive is compatible with Microsoft Windows 3.0, the 
Movie Editor does not use the Windows Clipboard for the Cut, Copy or Paste commands 
described below. Instead, the Movie Editor uses its own special paste and delete buffers for 
these commands. You can not paste items in these special buffers to another application; 
nor can you copy data from another application and paste it into the Movie Editor.



Movie Editor Menus: Edit Undo
When you select this command, the Movie Editor will undo your most recent action (if 
possible). This feature makes it easier for you to experiment with the placement of paths. If 
you delete a path and decide you don't like the result, select the Undo command to change 
it back.
The Undo menu item changes to reflect the last editing function performed. For example, if 
you use the Edit/Cut command to delete a path, the Edit menu will now contain the Undo 
Path Cut menu item.



Movie Editor Menus: Edit Cut
This command cuts the selected path out of the movie and places it in the Movie Editor's 
paste buffer.



Movie Editor Menus: Edit Copy
This command copies the selected path into the Movie Editor's paste buffer.



Movie Editor Menus: Edit Paste
This command pastes the most recent path that was cut or copied to the Movie Editor's 
special paste buffer into the movie starting at the current frame.
After choosing the Paste command, the path being pasted will attach itself to the cursor. 
Click the cursor at the position in the current frame where you want the path to start.



Movie Editor Menus: Edit Delete
This command removes the selected path from the Movie and puts it into the Movie Editor's 
special delete buffer.



Movie Editor Menus: Edit View
This command displays the contents of the Movie Editor's special buffers. The View 
command is disabled if the special buffers do not contain any images.
Selecting the View command displays the View Undo Buffers dialog box. This dialog box 
contains a list of paths saved in the special buffers. Paths that have been copied or cut are 
saved in the paste buffer with the name of the path appended to it. Paths that have been 
deleted are saved in the delete buffer with the name of the path appended. The name 
"Untitled" is appended if the path was not named.
If Preview is turned on, the selected path (and actor) is previewed in the Preview box.
The number of nodes and interactive events in the selected path are displayed at the 
bottom of the dialog box.
The Attributes button displays the attributes attached to the selected path.
The Interactive button displays the interaction attached to this path.
The Remove button removes the selected path from the special buffers.
The Done button returns you to the Movie Editor window.



Movie Editor Menus: Text Menu
The Text menu contains commands used in conjunction with the Quick Text tool from the 
Tools window. With Quick Text the attributes affect all text in the actor you are currently 
creating. They will also become the default attributes for any text created afterwards. 



Movie Editor Menus: Text Attributes
This command displays the Text Attributes dialog box which allows you to set display 
attributes for the selected text. These attributes are:
- Typeface - this list box contains the names of typefaces available on your system.
- Size - this lists the point sizes available for your system typefaces. You may also type in the
desired point size.
- Style - this lists the style options you can apply to your text. The available options are: 
Bold, Italic and Underline.
- Alignment - this allows you to align your text as left justified, center justified, or as right 
justified. A check mark is placed beside the current alignment setting.
- Word Wrap - When this feature is selected (a check mark appears beside it), text typed in 
the text entry box, using the Text tool, automatically wraps to the next line when it reaches 
the rightmost edge of the text box.
When word wrap is not selected, text stays on one line until you press the Enter key. This is 
useful when creating large titles that you want to scroll horizontally across the screen.
The default setting is Word Wrap on.
- Color... - this button displays the Select Color dialog box (showing the current color 
palette). You can then specify the color in which your text will appear. Click on the desired 
color and then click the OK button.



Movie Editor Menus: Text Edit
This command displays the Edit Text Actor window containing the current text actor.
You can then edit or modify the text. While the Edit Text Actor window is displayed, you can 
also select the Text/Attributes command and change the attributes of the text. See the 
Attributes command described above.



Movie Editor Menus: Options Menu
The commands under this menu allow you to toggle display and sound options on or off. 
These options include history, future, ghosting, borders, and sound. Another command 
under the menu allows you to set the sequence mode for the cels of your actor. The mode 
selected determines whether the cels are animated in a forward, backward, or ping-pong 
direction, or whether they remain still.



Movie Editor Menus: Options Cel Sequence Mode
This command displays a sub-menu which allows you to set the default cel sequence for 
new paths. The cel sequence is the sequence in which the cels of an actor are displayed 
along the path. 
Select Forward to animate the actor in a forward motion along the path. The path loops from
the actor's first cel to its last and back to its first cel again.
Select Reverse to animate the actor in a reverse motion along the path. The path loops from
the actor's last cel to its first and back to its last cel again.
Select Ping-Pong to animate the actor in a ping-pong or back-and-forth motion along the 
path. The path loops from the actor's first cel to its last and then backwards to its first cel 
again.
Select Still to display only one cel of the actor along the path.
This menu item sets the default sequence for new paths only. To change the cel sequence 
for existing paths use the Cel Sequence command in the Path Menu.



Movie Editor Menus: Options Screen Settings
This command displays the Screen Settings dialog box which allows you to select the type of
graphics display and resolution for your screen. 
You can alternatively set a custom screen definition by clicking on the Custom button and 
setting the number of horizontal and vertical pixels, the number of color bits per pixel, and a
choice of monochrome or color display.



Movie Editor Menus: Options Purge Unused
This command removes all unused backgrounds, actors, sounds, and wipes from memory. 
This is especially important where backgrounds are concerned. Backgrounds can take up 
significant amounts of memory and should be purged if not being used.



Movie Editor Menus: Options History
This command toggles the History feature on and off. A checkmark is displayed next to the 
menu item when the feature is on.
When the History feature is on and you are editing in the Movie Editor, the position of the 
current actor in the previous frame is displayed. This is useful when you are using the 
Registered Motion tool to create a path.



Movie Editor Menus: Options Future
This command toggles the Future feature on and off. A checkmark is displayed next to the 
menu item when the feature is on.
Identical to the History feature described above, the Future feature displays future images 
instead of history images.
The number of history or future images displayed can be increased (up to a maximum of 
ten) by pressing the Shift + Up arrow key sequence, or decreased (to a minimum of one) by 
pressing the Shift + Down arrow key sequence.
The History and Future options only affect the selected path. The commands are used 
primarily for editing purposes. (Use the Strobe effect in the Path Attributes dialog box to 
achieve a permanent effect for the path.)



Movie Editor Menus: Options Ghosting
This command toggles the Ghosting feature on and off. A checkmark is displayed next to the
menu item when the feature is on.
If either the History or the Future feature is on, the Ghosting command determines whether 
the history and future images will be displayed in a solid or faint style.



Movie Editor Menus: Options Borders
This command toggles the borders feature on and off. A checkmark is displayed next to the 
menu item when the feature is on.
When on, all actors are displayed with a solid border around them. This option has no effect 
in Full Frame Play mode.



Movie Editor Menus: Options Sound
This command toggles sound on and off. This allows you to prevent sounds from playing 
even if the current movie has sound events.



Movie Editor Menus: Options Display MCI Result
If this option is turned on, any MCI messages received during movie playback will be 
displayed in a dialog box.



Movie Editor Menus: GoTo Menu
The GoTo menu is a navigational tool. When you use the Marker command in the Event 
menu to give a name to a frame, this marker name is placed in the GoTo menu. Selecting a 
marker name from the GoTo menu makes the frame associated with that marker the current 
frame. If you get in the habit of setting marker events at key frames, it becomes very easy 
to navigate through your movie using the GoTo menu.



Movie Editor Menus: GoTo Cel Editor
This command invokes the Cel Editor application. If the Cel Editor was already running, it will
be brought to the front (activated). Note that the Movie Editor application will not be closed; 
it is simply overlayed by the Cel Editor window.



Movie Editor Menus: GoTo Background Editor
This command invokes the Background Editor. Note that the Movie Editor application will not
be closed; it is simply overlayed by the Background Editor window. 



Movie Editor Menus: GoTo Go to Frame #
This command displays a dialog box which allows you to specify the number of the frame to 
which you want to move. You are not allowed to enter a number larger than the total 
number of frames in the movie.



Movie Editor Menus: GoTo Next Event
This command allows you to move to the next event. This menu item will change to a 
specific event depending on the event last selected by the GoTo/Next command. For 
example, if the GoTo/Next/Sound command is selected, the Next Event menu item will 
change to Next Sound.



Movie Editor Menus: GoTo Next
This command displays a sub-menu from which you can select the type of event to go to. 
You can choose from the following event types:
- The next Background event
- The next Scroll event
- The next Wipe event
- The next Sound event
- The next Palette event
- The next Timing event
- The next Play Control event
- The next Marker event
- The next MCI event
- The next Cursor event
- The next Any (the next event of any type)



Movie Editor Menus: GoTo Previous Event
This command allows you to move to the previous event. This menu item will change to a 
specific event depending on the event last selected by the GoTo/Previous command. For 
example, if the GoTo/Previous/Background command is selected, the Previous Event menu 
item will change to Previous Background.



Movie Editor Menus: GoTo Previous
This command displays a sub-menu from which you can select the type of event to go to. 
You can choose from the following event types:
- The previous Background event
- The previous Scroll event
- The previous Wipe event
- The previous Sound event
- The previous Palette event
- The previous Timing event
- The previous Play Control event
- The previous Marker event
- The previous MCI event
- The previous Cursor Event
- The previous Any (the previous event of any type)



Movie Editor Menus: Frame Menu
This menu deals with the frames that comprise your movie. It allows you to add, duplicate or
delete frames.



Movie Editor Menus: Frame Add
This command allows you to add one or more frames (as specified in the Add Frames dialog 
box) before or after the current frame. Adding frames does not affect the number of nodes 
in the path.



Movie Editor Menus: Frame Duplicate
This command allows you to duplicate the current frame the number of times specified in 
the Duplicate Current Frame dialog box.
You can only copy the current frame, and not a range of frames.
Any paths in the frame being copied will be extended for a corresponding number of frames.



Movie Editor Menus: Frame Delete
This command allows you to delete a specified range of frames. Selecting the Delete 
command displays the Delete Frames dialog box which allows you to specify the range of 
frames you want deleted.
You can use the two scroll boxes to specify the start and end frames of the range to be 
deleted; alternatively, you can drag the scroll boxes to increase and decrease the frame 
numbers.
When the Delete Frames dialog box is displayed, both numbers are set to the current frame. 
Leaving both numbers unchanged deletes the current frame only.
You cannot set the End Frame number to less than the Start Frame number.
When you choose the Start and End Frames, the deletion is inclusive (that is, all frames 
between the two numbers, including the Start and End Frames, will be deleted).
If the Display Start Frame button is turned on, the specified Start Frame is displayed in the 
Movie Editor window.
If the Display End Frame button is turned on, the specified End Frame is displayed in the 
Movie Editor window.



Movie Editor Menus: Event Menu
Items in the Event menu cause a specific event to begin at the current frame.
Events are attached to specific frames and initiate an action such as a new background, a 
sound, or a change in timing.
All events stay in effect until the end of the movie, or until a new event of the same type is 
encountered, or, where applicable, until the end of the event.
Events such as background changes and timing changes which stay in effect until the end of
the movie or until a new event of the same type is encountered are called continuous 
events. Events such as wipes and sounds, on the other hand, have a specific duration and 
are called fixed duration events. 
The first frame of your movie is special in that it always has a number of default events in it.
These events are used to initialize the movie. They can be changed but not deleted. 



Movie Editor Menus: Event Select
This command displays the Select Event dialog box which allows you to select or delete any 
of the events in the current frame.
Click on an event in the list box on the left. The selected event will be previewed in the box 
on the right.
Click on Select to display the dialog specific to that event.
Double-clicking on an event in the list is equivalent to the above two steps.
Also, instead of selecting an event by name, you can scroll through events in the list box 
using the Previous and Next buttons.
Click on the Previous button to select the previous frame of the movie containing any event.
Click on the Next button to select the next frame of the movie containing any event.
Click on Remove to remove the selected event from the frame.
Click on Done to exit the dialog box.
Click on the Preview check box to disable the preview window. Clicking again in the check 
box will enable the preview window.



Movie Editor Menus: Event Background
This command allows you to change the background of the movie starting at the current 
frame.
You can choose from three sub-menus: Bitmap, Color Fill, and Gradient. Each of these 
options will set a new background event to begin at the current frame.
Selecting Event/Background/Bitmap displays a list of all Bitmap backgrounds currently 
available in memory, as well as an option to retrieve a Bitmap file from disk. Backgrounds 
are saved in the bitmap file format (with the filename extension .BMP or .DIB).
To load a background from disk, click on the Open button. This will bring up the Open 
Background dialog box, which allows you to select a Bitmap file from disk.
You also have the option to:
- Place the bitmap at the center of your stage
- Place the bitmap at the top left corner of your stage
- Tile the bitmap
Selecting Event/Background/Color Fill displays the current color palette, and allows you to 
create a background using any single color you pick. 
You cannot edit solid backgrounds in the Background Editor, and they do not appear in the 
Event/Background/Bitmap list.
Selecting Event/Background/Gradient allows you to create a gradient background from the 
colors you specify in the gradient dialog box. 
Gradient backgrounds created using this option are saved in memory and listed in the 
Background/Select dialog box. These gradient backgrounds are also available in the 
Background Editor for editing. The palette displayed in the Gradient window is always the 
current palette.
Double-click on a color in the color palette to add colors to your gradient.
You can repeat the above step more than once to add different colors to your gradient. The 
preview box in the upper left corner of the window displays the current gradient.
Click on the line on the Direction dial to set the direction for the gradient. Hold down the 
Shift key to constrain the movement of the line on the dial to 45-degree angles.
Click on Remove All to clear the gradient range.
Click on Remove Color to remove the selected color, which is selected by clicking on the 
color in the selected color list. 
Click on Dither Colors to use a dither pattern to blend between adjacent colors in the 
gradient. This is effective for eliminating the sharp edges between colors that lead to 
banding.
Click on Blend Colors if you want to use intermediate colors to blend between adjacent 
colors in the gradient. Blend Colors is most effective when working in 256-color mode.
With smaller palettes, it may yield unexpected results.
Gradients created in the Movie Editor and not edited in the Background Editor are saved as 
structures, and not as bitmaps. This means that they require only a fraction of the disk 
space normally needed to save a bitmap. Once you have edited the gradient in the 
Background Editor, the gradient is converted from a structure to a bitmap and will take 
significantly more disk space when saved.



Movie Editor Menus: Event Scrolling
This command sets a Scrolling Event at the current frame. This scrolls the background, 
allowing you to animate the background behind the paths.
For backgrounds wider than the screen, scrolling cycles the background across the screen, 
like a picture stretched around a rotating lamp shade.
The scrolling event stays in effect until a new scrolling event is reached.
Background changes do not affect the scrolling event; new backgrounds will scroll at the 
same rate as the old background.
To initiate scrolling set the starting and ending values of either the horizontal or vertical 
velocity, or both, to something other than zero.
To stop scrolling, set a new scrolling event with the starting and ending velocities for both 
the horizontal and vertical set to zero.
Diagonal scrolling is achieved by setting both the horizontal and vertical velocities to a value
other than zero.
Negative numbers will scroll the background from right to left and bottom to top.
Acceleration allows you to ease the background out of position in a smooth fashion. By 
setting an appropriate acceleration value together with a starting velocity of 0, you can 
avoid having the background jerk into motion.
The Starting Position option allows you to set the starting position of the background in the 
frame. This is useful when scrolling backgrounds that are larger than the frame.
By leaving the Starting and Ending velocities at 0, the Starting Position option allows you to 
offset a background in the frame.



Movie Editor Menus: Event Wipe
This command allows you to select a wipe to be used in your movie. Wipes allow you to 
introduce a new background in a dramatic way. The Wipe event is only available in frames 
that have a new background event.
When you select the Wipe command, a dialog box listing all available wipes is displayed.
Click on the desired wipe, then click on OK to use the wipe in your movie.
When the Wipe Backgrounds Only option is selected, paths starting before the new 
background event will not be wiped away with the old one. If the option is not selected, 
paths starting before the new background event will be wiped away by the incoming 
background; paths starting on or after the new background are also wiped by the new 
background.



Movie Editor Menus: Event Sound
Displays a submenu allowing you to select the type of sound event you want to start at the 
current frame. You can choose between Wave, MIDI, Compact Disc, and Kill All Sounds.
Wave
Adds a WAV sound sample to a movie at a current frame. Selecting this command displays 
the Select Wave Sound dialog box which lets you select any of the sounds currently stored in
memory. 
To hear the sound, click on the name and then click on the Play button.
If the sound you need is not currently in memory, click on the Open button to load the sound
from disk; this displays the Open Wave File dialog box.
Once you have selected and loaded a sound, the Select Wave Sound dialog box will be 
redisplayed, with the new sound highlighted in the list box.
Click on the Loop check box if you wish to play the selected sound over and over again.
Click on the Select button to add the sound to your movie.
To add this WAV sound to the current frame without leaving the Select Wave Sound dialog 
box, click on the Add button. This enables you to define or add other sounds before exiting 
the dialog box.
To add the same sound to another frame of your movie:
Move to the desired frame (using the Frame Scroll Bar, Previous Frame or Next Frame 
buttons on the Player window).
Click on the Add button in the Select Wave Sound dialog box. The sound will be added to the
specified frame of your movie.
To turn off an existing WAV sound at the current frame, select the Kill Wave Sound option, 
then click on the Select button.
Click on the Done button to return to the Movie Editor window.
All WAV sound events will play from start to finish unless interrupted by a new WAV sound 
event, a Kill WAV Sound event or a Kill All Sounds event.
MIDI
Adds a MIDI sound to a movie at a current frame. Multiple MIDI files can be played at any 
given time. Selecting this command displays the Select MIDI Sound dialog box which lets 
you select any of the MIDI files currently stored in memory. 
To hear the sound, click on the name and then click on the Play button.
If the sound you need is not currently in memory, click on the Open button to load the sound
from disk; this displays the Open MIDI File dialog box. Once you have selected the MIDI 
sound file on disk, the Select MIDI Sound dialog box will be redisplayed, with the specified 
sound highlighted in the list box.
Click on the Select button to add the MIDI sound to your movie.
To add this MIDI sound to the current frame without leaving the Select MIDI Sound dialog 
box, click on the Add button. This enables you to define or add other sounds before exiting 
the dialog box.
To add the same sound to another frame of your movie:
Move to the desired frame (using the Frame Scroll Bar, Previous Frame or Next Frame 
buttons on the Player window).
Click on the Add button in the Select MIDI Sound dialog box. The sound will be added to the 
specified frame of your movie.
To stop a MIDI sound at the current frame, select the Kill MIDI Sound option, then click on 
the Select button.
Click on the Done button to return to the Movie Editor window.
All MIDI sound events will play from start to finish unless interrupted by a new MIDI sound 
event, a Kill MIDI Sound event, or a Kill All Sounds event.
Compact Disc
Plays a Compact Disc sound at the current frame. Selecting this command displays the 
Select Compact Disc Sound dialog box which allows you to select any of the sound 
definitions currently stored in memory. 



To hear the sound, click on the name and then click on the Play button.
If the sound you need has not been previously defined, click on the Define button to display 
the Define Compact Disc Sound dialog box and create your definitions.
Enter the desired sound's starting track number and position on the compact disc in the 
Start group box. "Position" is the number of seconds from the beginning of the track.
Enter the sound's ending track number and position on the compact disc in the Stop group 
box.
Enter a name for the sound definition in the Name edit box.
Click on the OK button. The Select Compact Disc Sound dialog box is displayed again with 
the name of the sound and its start and end positions (T stands for track number and P 
stands for position).
If you wish to modify any of the definitions on the Select Compact Disc dialog box, select the
sound then click on the Edit button to display the Define Compact Disc Sound dialog box 
and modify the definitions.
To add this compact disc sound to the current frame and return to the Movie Editor window, 
click on the Select button.
To add this compact disc sound to the current frame without leaving the Select Compact 
Disc Sound dialog box, click on the Add button. This enables you to define or add other 
sounds before exiting the dialog box.
To add the same sound to another frame of your movie:
Move to the desired frame (using the Frame Scroll Bar, Previous Frame or Next Frame 
buttons on the Player window).
Click on the Add button in the Select Compact Disc Sound dialog box. The sound will be 
added to the specified frame of your movie.
Click on the Done button to return to the Movie Editor window.
The method of defining compact disc sound described above assumes that you know the 
track numbers and positions of the desired compact disc sound. You may find it easier to use
the interactive method described below. Let's assume that you wish to add a particular 
sound (e.g., a great speech) from a known track on a compact disc to your movie, but you 
don't know the sound's position on the compact disc, this method will allow you to preview 
the sound and quickly set your start and end positions:
Select the Event/Sound/Compact Disc command to display the Select Compact Disc Sound 
dialog box.
Click on the Define button to display the Define Compact Disc Sound dialog box.
Click on the Preview button to display the Preview Compact Disc dialog box.
Use the Track scroll bar to select the desired track.
Click on the Play button to start playing the sound on the selected track.
When the desired sound (the great speech) begins, click on the Set Start button. The 
corresponding position will be reflected in the Define Compact Disc Sound dialog box.
At the end of the desired sound, click on the Set Stop button. The corresponding position will
be reflected in the Define Compact Disc Sound dialog box.
All Compact Disc sound events will play from start to finish unless interrupted by a new 
Compact Disc sound event or by a Kill All Sounds event. The Kill Compact Disc Sound option 
allows you to stop a Compact Disc sound at a specific frame.
Kill All Sounds
Stops all sounds at the specified frame, including WAV, MIDI and Compact Disc sounds.



Movie Editor Menus: Event Palette
This command allows you to select the color palette to be used in the movie starting from 
the current frame to either the end of the movie, or until a new palette event is 
encountered.
Animation Works Interactive supports up to 256 colors. You can specify the number of 
colors you want to work with. The more colors you specify, the more work the program has 
to do and, generally speaking, the slower the animation.
While each actor may have been loaded with its own palette, when used in the Movie Editor,
they are displayed using the current palette. Be sure to match the color palettes of your 
actors to the current color palette or you may end up with unpredictable color results. 
You can remap your actors to a new palette in the Cel Editor.



Movie Editor Menus: Event Timing
This command allows you to change the playback speed of your movie. The new speed 
takes effect from the current frame to either the end of the movie or until another timing 
event occurs. Animation speed is measured in frames per second, and you set the rate by 
typing a number into the Frames Per Second edit box in the Timing Event dialog box.
While the Timing Event allows you to set the speed at which the movie is run (in number of 
frames per second), the event is constrained by the complexity of the movie and the 
limitations of the hardware. The more complex a movie is, the slower it runs.
If turned on, the Alert if movie cannot keep up option in the Timing Event dialog box will 
stop the movie and you will be informed that the movie can't be played at the requested 
speed. This feature is useful if you are trying to synchronize your animations with some 
external event such as video or sound, or if you are recording to a tape.



Movie Editor Menus: Event Play Control
This command allows you to control how your movie is played.
Pause...
Causes the movie to freeze on the current frame for the specified amount of time or, 
optionally, until a mouse click.
The time interval is specified in tenths of a second. 
The Pause until mouse click feature can add interaction to your movie. It is particularly 
useful during presentations, allowing you to control the progress of the movie.
Loop...
Causes the movie to loop back from the current frame to the frame whose marker you select
in the pop up menu. Markers are "names" attached to frame numbers. See the Marker 
section below for more information on markers.
There must be at least one marker prior to the current frame for the Loop menu item to be 
enabled.
Because you can only loop backwards, only markers attached to frames before the current 
frame will be listed in the pop up menu.
Options allow you to either loop a specified number of times or to loop indefinitely until a 
mouse click.
Note that you can only loop back to frames that have markers attached to them.
GoTo...
Causes the movie to move to the frame identified by the marker or frame number in the 
GoTo Event dialog box.
Range...
Causes the movie to play the frames within a specified range. Selecting this command 
displays the Play Range Event dialog box.
In the Start group box, specify the first frame in the play range (enter marker name or frame
number).
In the End group box, specify the last frame in the play range (enter marker name or frame 
number).
In the Return To group box, you can specify what happens after the selected range has been 
played. The movie will jump back to the return location specified; either the current frame or
the next frame.
Stop
Causes the movie to stop playing at the current frame.
Play AWI Movie...
Causes another movie to be played from within the current movie. Selecting this command 
displays a file requester to select the movie to play. When your movie reaches this frame it 
will load the other movie specified, play that movie, then return to the current movie. 
Although this feature (embedding movies) is added to a movie in the Movie Editor, its effect 
can only be seen while playing the movie with the Movie Player.



Movie Editor Menus: Event Marker
This command displays the Marker dialog box which allows you to assign a name to the 
current frame. The name you specify in the Marker Name edit box then appears in the GoTo 
menu facilitating speedy navigation through lengthy productions. Setting marker events can
make it easier for you to edit your productions.
Markers are also used in the Loop event to specify the frame you wish to loop back to. They 
are also used in the Range and GoTo dialogs.
A frame can have one or many markers attached to it. Markers can sometimes be added to 
frames automatically when you start deleting other frames. If you delete a frame that has a 
marker event set in it, the marker event is shifted to the next frame. If a marker event is 
already set on that frame, it will now have two marker events.



Movie Editor Menus: Event MCI
Selecting MCI (Media Control Interface) will display the MCI dialog box. This dialog box 
allows you to type in a text string to pass an MCI command to Windows. MCI commands 
allow you to control a piece of hardware such as a video disc player or VCR, or control other 
programs that have MCI drivers, with simple text commands.
To attach an MCI command to the current frame:
Select Event/MCI. The MCI dialog box will be displayed.
Type in the command string you wish to issue.
Click on the OK button.
When Animation Works Interactive reaches this frame number while playing, it will pass 
the MCI command to Windows.
If the device returns a message as a result of the MCI command, you can see the message 
by enabling the Display MCI Result menu item in the Options menu.
For more specific information on MCI and MCI Drivers please refer to the Windows 
Multimedia Extensions documentation or contact the manufacturer of the device you wish to
control.



Movie Editor Menus: Event Cursor
The Cursor event allows you to turn the cursor on and off. This is useful as you will likely 
want the cursor to be invisible during the playing of your movies, but you will want it visible 
during interaction so that the user can see where it is. When turning the cursor on, you can 
set the location on screen where you want it displayed. This can also be useful to force the 
cursor to a specific screen location.



Movie Editor Menus: Path Menu
The Path menu provides a variety of tools that can operate on the selected path in your 
movie. 
With the exception of the Select command, which lets you select a path to work with, all of 
the options in this menu are unavailable until a path is selected.
Paths are selected by either clicking on the actor associated with the path or using the 
Path/Select command discussed below.



Movie Editor Menus: Path Select
This command displays the Select Path dialog box which allows you to select or remove any 
of the paths in the current frame.
This is particularly useful when you have a lot of paths in a movie and are unable to select a 
particular path because its actor is obstructed by another.
The Select Path dialog box also shows some information about the selected path, such as 
the number of nodes and number of events attached to the path.
The Attributes button allows you to view or edit the selected path's attributes (see Attributes
command in this section for details).
The Interactive button allows you to map mouse buttons or keyboard keys to perform 
certain actions while playing your movie.
The Go To Previous Path and Go To Next Path buttons takes you to the previous or next 
frame that has a new path beginning on that frame.



Movie Editor Menus: Path Attributes
This command allows you to set various attributes for the current path. Selecting this 
command displays the Path Attributes dialog box.
Enter a name for the path in the Path Name edit box.
In the Strobe group box:
Enter the number of history and future cels you want displayed in the current frame.
Enable Ghosting for the history and future cels, if desired.
The strobe effect displays previous and/or future positions of the actor in the current frame 
for dramatic "trail" effects.
Interaction
When the movie is being played with the Movie Player, the only controls you have over the 
movie are those already built-in and saved with the movie. You can't make the movie jump 
to another frame, for example, if that control wasn't already saved with the movie. In other 
words, you can't interact with a movie while it is being played in the Movie Player unless you
use the Interaction feature of Animation Works Interactive.
Interaction allows you to control the flow of movies while they are being played in the Movie 
Player. You simply map a special control action to a keyboard key or mouse button. Then, 
while the movie is playing, you make the movie perform the special action (such as play a 
sound, jump to a frame, or start another movie) by pressing the mapped key or clicking on 
the mapped mouse button.
Note that interaction is associated with paths, not frames. If for example, you have mapped 
a single click of the right mouse button to advance a movie to the last frame, clicking on the
actor in any portion of the path invokes the advance.
The following actions can be mapped to keyboard keys or mouse buttons for interaction:
- Wave Sound
Plays a wave sound saved in the WAV format.
- MIDI Sound
Plays a MIDI sound saved in the MID format.
- Compact Disc
Plays the sound from the specified track and position of a Compact Disc.
- Pause
Pauses the movie until the specified duration elapses or the mouse button is clicked.
- Play Range
Plays the specified range of the movie.
- Go To
Advances (or rewinds) the movie to the specified frame number or marker.
- Stop
Stops the movie.
- Play Movie
Embeds another movie within a movie. While Movie A is playing, for example, this stops 
Movie A, plays Movie B, and then returns to Movie A. Movie B, however, can not play 
another movie. The Play Movie event can only go one level deep.
Note: For the interactive Play Movie action to be effective, the movie must be played with 
the Movie Player (a special program for playing your completed movies), not with the Movie 
Editor. 
- MCI
Executes a Windows Media Control Interface (MCI) command.

Adding Interaction to Movies
To add Interaction to your movies:
Select the desired path (click on the actor).
Select the Path/Interaction command; the Path Interaction dialog box is displayed.
From the Input Initiation group box, select a mouse sequence (click and/or double click the 
left and/or right mouse button) and/or select the Keystroke option and press the desired 



keyboard key.
Note that the key pressed is displayed in the Keystroke edit box.
From the Action Taken group box, select the desired action you wish to map to the selected 
key or mouse button.
What happens next depends on the option you selected in the Action Taken group box:
Wave Sound
If you selected Wave Sound:
Click on the Setup button to display the Select Wave Sound dialog box, which contains a list 
of available sounds.
From the Select Wave Sound dialog box, you have the following options:
Click on the Open button to load a sound file from disk.
Click on the Play button to play a selected sound.
Click on the Remove button to remove a selected sound from the list.
Choose the sound you desire and then click on the Select button to select the sound as the 
action.
Click on the Done button to return to the Path Interaction dialog box.
Click on the OK button to exit the Path Interaction dialog box.
MIDI
If you selected MIDI Sound:
Click on the Setup button to display the Select MIDI Sound dialog box which contains a list of
available sounds.
From the Select MIDI Sound dialog box, you have the following options:
Click on the Open button to load a MIDI file from disk.
Click on the Play button to play the selected sound.
Click on the Remove button to remove a selected sound from the list.
Choose the sound you desire and then click on the Select button to select the sound as the 
action.
Click on the Done button to return to the Path Interaction dialog box.
Click on the OK button to exit the Path Interaction dialog box.
Compact Disc
If you selected Compact Disc:
Click on the Setup button to display the Select Compact Disc Sound dialog box. This allows 
you to select any of the sound definitions currently stored in memory.
From the Select Compact Disc Sound dialog box, you have the following options:
Click on the name of the sound and then click on the Play button to hear the sound.
Define a new Compact Disc sound.
To define a new Compact Disc sound:
Click on the Define button to display the Define Compact Disc Sound dialog box.
Note: The next four steps assume that you know the track number and position of the 
desired sound on the Compact Disc. If you don't know these parameters, use the interactive 
method described later to create your definitions (see the next note).
In the Define Compact Disc Sound dialog box, enter the desired sound's starting track 
number and position on the compact disc (in the Start group box). Position is the number of 
seconds from the beginning of the track.
Enter the sound's ending track number and position on the compact disc (in the Stop group 
box).
Enter a name for the sound definition in the Name edit box.
Click on the OK button. The Select Compact Disc Sound dialog box is displayed again with 
the name of the sound and its start and end positions (T stands for track number and P 
stands for position).
If you want to change a sound's definitions in the Select Compact Disc dialog box, select the
sound then click on the Edit button to display the Define Compact Disc Sound dialog box 
and modify the sound's definition.
Click on the Done button to return to the Path Interaction dialog box.
Note: The method of defining a compact disc sound described above assumes that you 



know the track numbers and positions of the desired sound. You may find it easier to use the
interactive method described below.
Let's assume that you wish to add a particular sound (e.g., a great speech) from a known 
track on a compact disc to your movie, but you don't know the sound's position on the 
compact disc; this method will allow you to preview the sound and quickly set your start and
end positions:
With the Select Compact Disc Sound dialog box displayed, click on the Define button to 
display the Define Compact Disc Sound dialog box.
Click on the Preview button to display the Preview Compact Disc dialog box.
Use the Track scroll bar to select the desired track.
Click on the Play button to start playing the sound on the selected track.
When the desired sound (the great speech) begins, click on the Set Start button. The 
corresponding position will be reflected in the Start group box of the Define Compact Disc 
Sound dialog box.
At the end of the desired sound, click on the Set Stop button. The corresponding position will
be reflected in the Stop group box of the Define Compact Disc Sound dialog box.
Click on the Done button to return to the Path Interaction dialog box.
Click on the OK button to exit the dialog box.
Pause
If you selected Pause:
Click on the Setup button to display the Pause Event dialog box.
Either enable the Pause for time duration option and enter the duration (in tenths of a 
second) in the edit box, or enable the Pause until mouse click option. The first option will 
pause the movie until the specified time interval elapses; the second option will pause the 
movie until you click the mouse button.
Click on the OK button to return to the Path Interaction dialog box.
Click on the OK button to exit the dialog box.
Play Range
If you selected Play Range:
Click on the Setup button to display the Play Range Event dialog box.
In the Start group box, specify the first frame in the play range (enter marker name or frame
number).
In the End group box, specify the last frame in the play range (enter marker name or frame 
number).
In the Return To group box, specify what happens after the specified frames of the movie 
has been played; the movie either returns to the current frame or the frame after the 
current one.
Click on the OK button to return to the Path Interaction dialog box.
Click on the OK button to exit the dialog box.
Go To
If you selected Go To:
Click on the Setup button to display the GoTo Event dialog.
Specify the marker name or frame you wish to jump to.
Click on the OK button to return to the Path Interaction dialog.
Click on the OK button to exit the dialog.
Stop
If you selected Stop:
Click on the Setup button to display the Stop Event dialog box.
If you select Stop Playing, the movie will always stop playing.
If you select End of Movie, the movie will stop playing if Continuous Play mode is turned off. 
If Continuous Play mode is on, the movie will jump back to the beginning and play again.
Click on the OK button to return to the Path Interaction dialog.
Click on the OK button to exit the Path Interaction dialog box.
Play Movie
If you selected Play Movie:



Click on the Setup button to display the Open Movie dialog box.
From the Files group box, select the movie you wish to embed.
Click on the Open button to return to the Path Interaction dialog box.
Click on the OK button to exit the dialog box.
MCI
If you selected MCI:
Click on the Setup button to display the MCI Command dialog.
Enter the MCI command in the text box
Click on OK to return to the Path Interaction dialog.
Click on OK to exit the Path Interaction dialog.
Text Transition
This command is used to add transitions to text actors to bring the text on screen, and to 
move the text off screen. This command is only available when you have a path with a text 
actor selected. Selecting the Path/Text Transition command will display the Text Path 
Transition dialog box. This dialog box is used to tell Animation Works Interactive how to 
move the text to and from the selected path that you have selected.
In this dialog you must specify the number of frames for the text actor to be visible on 
screen; this is the number of frames in the path. Enter this number in the Number of frames 
edit box.
Two transition options are available. The first is an Entry Transition. This is the transition 
used to move the text onto the screen. The second is the Exit Transition. This is the 
transition used to move the text off the screen. If you entered 100 in the Number of Frames 
edit box and had no Entry or Exit transition, the text would remain on the path as it is on 
screen for 100 frames.
The Entry Transition group box allows you to specify the number of frames for the Entry 
Transition to take, as well as the direction of entry from and the type of transition. Enter the 
number of frames in the edit box to specify the number of frames to use for the Entry 
Transition. This number must be less than the number of frames for the path. Use the drop 
down list to select the type of transition you desire, and the direction in which the motion is 
to occur.
The Exit Transition group box is the same as the Entry Transition group box except that it 
specifies the transition, number of frames, and direction for the text to leave the screen. The
number of frames in the Entry Transition box added to the number of frames in the Exit 
transition box must not exceed the total number of frames in the path.
Click on OK to add these transitions to your text actor path.
To edit these transitions, select the text path and then select Path/Text Transition to 
redisplay the Text Transition dialog.



Movie Editor Menus: Path Adjust
This command displays a dialog box which allows you to set the total number of frames for 
the path, the acceleration at the beginning, and the deceleration at the end.
Enter the number of frames over which you want the actor to reach normal speed in the 
Accelerate for first edit box.
The illusion of an actor speeding up is achieved by starting with the actor's path nodes close
together and gradually spreading them out over the number of frames you specify.
Acceleration is known as easing-in, because it allows an actor to ease-in to its motion in a 
natural way rather than looking like it jerked into motion.
Enter the number of frames over which you want the actor to slow to a stop in the 
Decelerate for last edit box.
The illusion of an actor slowing down is achieved by starting with the actor's path nodes far 
apart and gradually decreasing the spacing over the number of frames you specify.
Deceleration is known as easing-out, because it allows an actor to ease-out of its motion in a
natural way rather than coming to an abrupt stop. 
Properly accelerating and decelerating actors gives their motion more realism.
Click on the To End button to automatically calculate the number of frames from the current 
frame to the end of the movie.
Clicking on To End only calculates the number of frames to the end of the movie at the 
current time. If you were to add more frames subsequently, and wanted the path to extend 
to the new end, you would have to re-select the Path/Adjust command, and click on the To 
End button again.
Click on OK to confirm your selections.
Clicking OK in the Adjust Path dialog box redistributes the frames along the path according 
to the settings you have made. While the line that defines that path will not be altered, the 
individual cels along the path will be redistributed regardless of how they were created. Path
Freezes, for example, will no longer be in place after you adjust the path.
Click on Cancel to exit without redistributing the path.



Movie Editor Menus: Path Cel Sequence
This command displays the Cel Sequence dialog box which allows you to change the 
sequence in which the cels of a path's actor are displayed along the path.
Click on the Forward button to animate the actor in a forward motion along the path.
Click on the Reverse button to animate the actor in a reverse motion along the path.
Click on the Ping Pong button to animate the actor in a ping-pong, or back-and-forth motion 
along the path.
Click on the Still button to display only one cel of the actor along the entire path.
You can also specify how often the actor's cel should be changed. For example, you can 
specify that a bird's cels should change every other frame. This will result in the bird 
flapping its wings at half the speed of a bird whose cels change every frame.
Enter a number in the # of Frames to Cycle Cels edit box. This number determines how 
often the cels change.
Finally, you can specify what portion of the path is to be affected by the above changes:
Click on the To Entire Path button to apply the new settings to the entire path.
Click on the From Current Frame to End button to apply the changes to the portion of the 
path from the current frame to the end of the path.
Click on the From Start to Current Frame button to apply the changes to the portion of the 
path from the beginning of the path to the current frame.



Movie Editor Menus: Path Delete
The options in this sub-menu are used to delete the selected path, or part of the path.
Entire Path
This command will delete the current selected path.
Current Node
This command will delete the current node in the current path.
Start to Node
This command will delete the nodes in the path from the first node of the path to the current
node, inclusive.
Node to End
This command will delete the nodes in the path from the current node to the end of the 
path, inclusive.



Movie Editor Menus: Path Change Actor
This command replaces the actor of the current path with the actor displayed in the Actor 
window. If both actors are the same, this command is disabled.
Make sure the path whose actor you want changed is the current path. To make it current, 
click on its actor in the current frame, or use the Select command from the Path menu.
Select the actor you want to change to in the Actor window.
Choose Change Actor.



Movie Editor Menus: Path Freeze
This command allows you to freeze the current position and cel of the actor for a specified 
number of frames. This is done by inserting additional nodes in the path. Hence the path is 
actually extended.
Tip
Selecting Adjust from the Path menu after using the Freeze feature will redistribute the 
frames along the path and eliminate the effect of the freeze.



Movie Editor Menus: Path Repeat
This command allows you to repeat the portion of the current path from the start of the path
to the current frame over the number of frames you choose. This portion will then be 
repeated (i.e., inserted) after the current frame.
Tip
This feature is most useful where paths are cyclical. For example, if you want an actor to 
follow a circular path for multiple revolutions, create one complete cycle of the path, go to 
the last frame of the path, and then use Path/Repeat to repeat the path over as many 
frames as you need.



Movie Editor Menus: Path Extend
This command extends the current path from the current frame for a specified number of 
frames.
Unlike Repeat, this command intelligently extends the path by following the pattern 
established by the path prior to this frame.
You can only extend a path after you have created enough of a path to establish a pattern.
The most common use of this command is for extending paths created with the Registered 
Motion tool. 



Movie Editor Menus: Path Center
This command is used to center the bounding rectangle of the current actor image in the 
current frame relative to the screen. The whole path of the actor will me moved such that 
it's position relative to the centered image will remain the same.
Horizontally
This will center the current cel of the actor on the selected path horizontally on screen.
Vertically
This will center the current cel of the actor on the selected path vertically on screen.
Both
This will center the current cel of the actor on the selected path both horizontally and 
vertically on screen.



Movie Editor Menus: Path Go To Start
This command makes the first frame of the selected path the current frame.



Movie Editor Menus: Path Go To End
This command makes the last frame of the selected path the current frame.



Movie Editor Menus: Path Magnetize
This command allows you to attach the current path to another, thereby creating hierarchies
of motion. 
After selecting the Magnetize command the cursor turns to a magnet.
To magnetize the current path to a different path:
After selecting the Path/Magnetize command, click on the actor of the path to which you 
wish to magnetize the current path.
The magnet will change shape so that the ends point inward when it is over a path you can 
magnetize to. You can't magnetize when the ends of the magnet don't point inward.
Once you have selected the actor of the path to which you wish to magnetize, the current 
path will be magnetized to that path.
The Path/Magnetize menu item will have a checkmark beside it when the path that is 
currently selected is a child path magnetized to another path. By selecting the 
Path/Magnetize menu item when it is checked, you can de-magnetize the selected path. 
After this operation, it will no longer be a child to another path.
Magnetize sets up a child-parent relationship. The motion of the parent is added to the 
motion of the child.
The path that is current when you select the Magnetize command is the child in the 
relationship; the path of the actor that you select with the magnet cursor is the parent. A 
parent can have as many children as needed. A child can also be a parent, having children 
of its own.
Tip
The Magnetize command is most useful when creating complex motions. As an example, 
suppose you were creating an animation of the solar system: You would need to show the 
Earth circling the Sun while the Moon circles the Earth. The motion of the Moon in such an 
animation would be very difficult to create. However, with hierarchical paths, you create a 
circular path for the Moon and a circular path for the Earth. You then magnetize the Earth's 
path to the Sun, and the Moon's path to the Earth.



Movie Editor Menus: Window Menu
This menu controls which windows (Player, Tools, Actor, Status) are displayed on the Movie 
Editor workspace and also how the windows are displayed.



Movie Editor Menus: Window Arrange
If any of the Movie Editor windows have been moved from their default positions, the 
Window/Arrange command returns the windows to the default positions.



Movie Editor Menus: Window Auto Arrange
This command determines whether the Player, Tools and Actor windows remain in their 
default positions when the Movie Editor window is resized or moved.
If Auto Arrange is toggled on (indicated by a check mark beside the menu item) and the 
Movie Editor window is resized or moved, the Player, Tools and Actor windows will be moved 
to the corners of the Movie Editor window.
If Auto Arrange is toggled off, the windows will remain in their current positions regardless of
the new location or size of the Movie Editor window.



Movie Editor Menus: Window Cue Sheet
This command displays a text list, or text-based overview, of events that occur on each 
frame of your movie.
Cue Sheets are ideal for getting an overview of the structure of your movie. You can see at a
glance where events such as loop points and background changes are located.
Clicking on a line in the Cue Sheet will take you to that frame number in the movie.
Click on the Print button to print the current Cue Sheet.
Click on the Options button to set which frames are shown in the Cue Sheet window.
The following customization options are available:
Show all frames or only frames that meet certain conditions (Conditions or All Frames).
Conditions to display.
You can select which types of events will show up in the Cue Sheet window. For example, 
you could list all frames with Background Scroll events.

Printing
If you have installed a raster printer which supports bitmap transfers using the Windows 
Control Panel, you can print the Storyboard or Cue Sheet. When printing, the Movie Editor 
uses the printer selected in the Control Panel. To print the Storyboard or Cue Sheet, select 
the Print button located at the top of your Storyboard or Cue Sheet window. A Print Options 
dialog box appears containing the following options:

Frames
You can indicate which frames will be included in the print operation. Your choices 
are:
- MATCHING CONDITIONS
Prints only those frames that meet the conditions specified in the Storyboard/Cue 
Sheet Options dialog box.
- ALL FRAMES
Prints every frame in the movie subject to the "Every nth Frame" option.
- FRAMES FROM/TO
Prints a range of frames subject to the "Every nth Frame" option.
You specify the starting and ending frame numbers in the From and To edit boxes.

Movie Name at Page Top
When checked, the filename of the movie will be printed at the top-center of the each
printed page.

Page Number at Page Bottom
When checked, the page number will be printed at the bottom-center of the each 
printed page.

Printer Setup Button
Selecting the button will display a setup dialog box containing the current print 
options for the selected printer. This setup dialog will show the options specific to the 
printer driver you have installed. You can change any of the print options in this 
dialog.

Print Button
Select this button to begin the print operation.

Once printing has started, a dialog box will appear indicating the current page being printed.
You may stop printing at any time by selecting the Abort button in this dialog.





Movie Editor Menus: Window Cue Sheet Options
This command displays the Cue Sheet Options dialog box which allows you to customize the
Cue Sheet. The customization options are:
- Show all frames or only frames that meet certain conditions (Conditions or All Frames).
Conditions to display.
You can select the types of events which will show up in the Cue Sheet window. For example,
you could display all frames with Background Scroll events.



Movie Editor Menus: Window Storyboard
This command displays a visual overview or summary of your movie. Selecting this 
command displays the Storyboard window. The frames of your movie are displayed in a 
tabular format, with relevant information about each frame (new paths and events set to 
start in the frame) displayed below it.
The storyboard is also a useful navigational tool. Clicking on a frame in the Storyboard 
window highlights the frame and makes it the current frame in the Movie Editor window.
The Options button in the Storyboard window displays the Storyboard Options dialog box 
which allows you to customize the storyboard by selecting its contents and format.

Printing
If you have installed a raster printer which supports bitmap transfers using the Windows 
Control Panel, you can print the Storyboard or Cue Sheet. When printing, the Movie Editor 
uses the printer selected in the Control Panel. To print the Storyboard or Cue Sheet, select 
the Print button located at the top of your Storyboard or Cue Sheet window. A Print Options 
dialog box appears containing the following options:

Frames
You can indicate which frames will be included in the print operation. Your choices 
are:
- MATCHING CONDITIONS
Prints only those frames that meet the conditions specified in the Storyboard/Cue 
Sheet Options dialog box.
- ALL FRAMES
Prints every frame in the movie subject to the "Every nth Frame" option.
- FRAMES FROM/TO
Prints a range of frames subject to the "Every nth Frame" option.
You specify the starting and ending frame numbers in the From and To edit boxes.

Movie Name at Page Top
When checked, the filename of the movie will be printed at the top-center of the each
printed page.

Page Number at Page Bottom
When checked, the page number will be printed at the bottom-center of the each 
printed page.

Print Backgrounds
When checked, the background image of the frames will be included in the print 
operation; otherwise, the backgrounds will not be printed.

Number of Columns
Allows you to format the printed page by indicating the number of columns.

Width
Allows you to specify the width (in inches) of each printed frame.
The height of the frame will be automatically calculated so that the width/height ratio
will be the same as your current screen configuration.

Spacing
Allows you to specify the spacing (in inches) between each printed frame.

Printer Setup Button
Selecting the button will display a setup dialog box containing the current print 



options for the selected printer. This setup dialog will show the options specific to the 
printer driver you have installed. You can change any of the print options in this 
dialog.

Print Button
Select this button to begin the print operation.

Once printing has started, a dialog box will appear indicating the current page being printed.
You may stop printing at any time by selecting the Abort button in this dialog.



Movie Editor Menus: Window Storyboard Options
This command displays the Storyboard Options dialog box which allows you to customize 
the storyboard. The customization options are:
- Items to preview (Screen, Text or Both).
- Size of frames in the storyboard (Small, Medium or Large).
- Show all frames or only frames that meet certain conditions (Conditions or All Frames).
Conditions to display.
You can select the types of events which will show up in the Storyboard window. For 
example, you could display all frames with Background Scroll events.



Movie Editor Menus: Window Player
This command toggles the display of the Player window on and off. A check mark beside the
command indicates that the window is displayed.



Movie Editor Menus: Window Tools
This command toggles the display of the Tools window on and off. A check mark beside the 
command indicates that the window is displayed.



Movie Editor Menus: Window Actor
This command toggles the display of the Actor window on and off. A check mark beside the 
command indicates that the window is displayed.



Movie Editor Menus: Window Status
This command toggles the display of the Status bar on and off. A check mark beside the 
command indicates that the status bar is displayed.



Movie Editor Menus: Help Menu
The commands under this menu display on-line help information and copyright information 
about the program.



Movie Editor Menus: Help Index
Help/Index, will bring up a window with a list of the different subjects available for help. 
Clicking on a heading in the index will bring up more information about that topic.
Some of these topics are also listed in the Help menu itself. This allows you to jump directly 
to that topic without going through the Index. For more information on using the Help menu,
select Help/Using Help.



Movie Editor Menus: Help About Movie Editor
This command displays copyright information about the Animation Works Interactive 
Movie Editor. The version number of the program is also displayed. Please have this number 
at hand when calling or writing to the Technical Support department.



Movie Editor Shortcut Keys
Miscellaneous
Screen scroll Arrow keys, Page Up,

Page Down, Home, End

Tools Window
QuickText tool Shift+Ctrl+A
Path tools Shift+Ctrl+P

Actor Window
Open actor file Ctrl+O

Priority
While selecting either priority tool:
Step path through priority layers. Priority Tool Button
Change priority of path to
extreme first or last layer. Double Click Priority Button
Step current node through
priority layers. Shift+Priority Button
Change priority of current node to
extreme first or last layer. Shift+Double Click Priority Button
Step path from current node to end
of path through priority layers. Alt+Priority Button
Change priority of current node
to end of path to extreme first or
last layer. Alt+Double Click Priority Button
Step path from beginning of path to
current node through priority layers. Ctrl+Priority Button
Change priority of beginning of path
to current node to extreme
first or last layer. Ctrl+Double Click Priority Button

Player Window
Toggle Full Screen/Edit Play Shift+Alt+F
Toggle Continuous Play (loop) mode Shift+Alt+L
Play forward Shift+Alt+P
Stop play Esc, Shift+Alt+P (in Edit Mode)
Go to first frame Shift+Alt+Home, or

Shift+Alt+Up Arrow
Go to last frame Shift+Alt+End, or

Shift+Alt+Down Arrow
Go to next frame Shift+Alt+Right Arrow
Go to previous frame Shift+Alt+Left Arrow
Advance 10 frames Shift+Alt+Page Down
Rewind 10 frames Shift+Alt+Page Up
Quick movie scroll with player window
film scroll bar
(screen not updated until done) Hold down Ctrl while dragging

frame number box

Paths & Nodes
Delete selected path Delete
Duplicate a path Ctrl+Click and drag path's actor



Change cel face Shift+Right Arrow, Shift+Left Arrow
Go to the frame of a specific
path node. Ctrl+Click on node
Delete last placed node during
registered motion Ctrl+Delete
Delete current node Ctrl+Delete
Move actor's current node Space+Click and drag actor
Display Adjust Path dialog Double Click on paths actor
Display Cel Sequence dialog Shift+Double Click on path's actor
Display Quick Text edit box for
a path with a text actor Shift+Double Click on path's actor
Constrain Key Hold Shift or

Right Mouse Button
while performing action

Constrains:
- line/polygon path to 45 degree steps
- curved path to a perfect circle
- gradient angle dial to 45 degree steps







Cel Editor Tools Window: Selection Tools
These tools are used to select images (or portions of images) in the Cel Editor window. All 
selections are initiated by clicking the mouse button at a starting location.



Cel Editor Tools Window: Lasso Selection Tool
This tool is used to select a portion of your image freehand.
Select the Lasso Selection tool.
Click and drag the mouse around the area you want to select.
Once you release the mouse button, the selected area will be enclosed by a dotted line.



Cel Editor Tools Window: Rectangle Selection Tool
This tool is used to select a portion of your image by dragging a rectangle around it.
Select the Rectangle Selection tool.
Click to set one corner of the rectangle and drag to the opposite corner.
Holding down the shift key while draging out the rectangle constrains its shape to be a 
perfect square.



Cel Editor Tools Window: Polygon Selection Tool
This tool is used to select a portion of your image by enclosing it in a polygon.
To enclose the image in a polygon:
Select the Polygon Selection tool.
Click the mouse button at the desired starting point on the screen.
Continue clicking the mouse button at points around the screen, building a polygon that 
encloses the image.
Holding down the shift key while draging a line in the polygon constrains its direction to a 
multiple of 45 degrees.
Double click the mouse button to finish the selection.



Cel Editor Tools Window: Paint Tools
The paint tools are the standard painting tools used for creating images.



Cel Editor Tools Window: Eraser Tool
This tool is used for erasing areas of the image.
Select the Eraser tool.
Press and hold the mouse button, then drag the mouse over the area you want erased.
Holding down the shift key while draging the eraser constrains its movements to the vertical
or horizontal directions.
To erase the contents of the entire cel, double-click the Eraser tool.
To change the size of the eraser, use the Pen Width dialog.



Cel Editor Tools Window: Grabber Tool
The grabber tool allows you to move the entire cel's image to a different location on the 
screen.
Click on the the Grabber tool.
Click and drag the cel image to the desired location in the editing window.
When the cel's image is being dragged the edit window will automatically scroll when you go
past the edit window's edge.
If any portion of the image is moved and placed outside the borders of the drawing area it 
will be clipped off.



Cel Editor Tools Window: Paint Brush Tool
This tool is used to paint on the screen using the current pen color and width.
Select the Paint Brush tool.
Click and drag on the screen where you wish to paint.
Double- clickingwill bring up the Pen Widths dialog.
Holding down the shift key will constrain the paint brush to moving along the x or y axis.
You can use the keyboard arrows to draw also.
You can change the size of the brush by using the Pen Width dialog.



Cel Editor Tools Window: Paint Bucket Tool
This tool is used to fill an enclosed area with the current fill color and pattern.
Select the Paint Bucket tool.
Click within the area you wish to flood fill.
To quickly display the Fill Pattern dialog you can double click on the Paint Bucket tool.



Cel Editor Tools Window: Pencil Tool
This tool is used to draw a one-pixel thick line using the current pen color.
Select the Pencil tool.
Click and drag to draw.
Holding down the shift key will constrain drawing to the x or y axis.
To quickly display the Pen Width dialog you can double click on the Pencil tool.



Cel Editor Tools Window: Air Brush Tool
This tool is used to spray-paint an area.
Select the Air Brush tool.
Click and drag to spray the desired area.
Holding down the shift key will constrain drawing to the x or y axis.
To quickly display the Pen Width dialog you can double click on the Air Brush tool.



Cel Editor Tools Window: Zoom Tool
This tool is used to magnify an area.
Select the Zoom tool.
Click at the spot you wish to be in the center of the magnified area.
To return to normal magnification, click on the Zoom tool again, close the Zoom preview 
window, or press the ESC key.



Cel Editor Tools Window: Text Tool
This tool is used to create bitmapped text.
Clicking on the Text tool brings up a text editing box where text can be entered and edited.
To customize your text, select Attributes/Text.
A dialog box will appear allowing you to change the font, font size, style alignment, and 
color. See Text/Attributes in the Movie Editor section for a more in-depth discussion of the 
Text Attributes dialog box.
To re-size the Text Edit box, position the cursor over the borders at any of the corners of the 
box or along the edges of the box and drag it to the desired size.
To reposition the text onto your image, press the Esc key, drag the text to a desired location 
and click the mouse button.
Pressing the ESC key while dragging the text will cancel the operation.



Cel Editor Tools Window: Straight Line Tool
This tool is used to draw a straight line in the current line width and pen color.
Select the Straight Line tool.
Click at the starting point of the line and drag the mouse to draw the line.
Holding down the Shift key while dragging will constrain the line to the nearest 45-degree 
angle.
To quickly display the Pen Width dialog you can double click on the Straight Line tool.



Cel Editor Tools Window: Shape Tools
There are two sets of Shape Tools in Animation Works Interactive. The first set will draw 
the shape with the current pen color, and fill it with the current fill color. The second set will 
just draw the shape with the current pen color, without filling it.
To quickly display the Pen Width dialog you can double click on any of the Empty Shape 
tools.
To quickly display the Fill Pattern dialog you can double click on any of the Filled Shape tools.



Cel Editor Tools Window: Rectangle Tool
This tool is used to draw a rectangle or square.
Select the Rectangle tool.
Click the mouse at the start location of the shape and drag to the shape's ending position.
Release the mouse to finish drawing the shape.
Holding down the Shift key while dragging will constrain the rectangle to a square.



Cel Editor Tools Window: Oval Tool
This tool is used to draw an oval or circle.
Select the Oval tool.
Click the mouse at the start location of the shape and drag to the shape's ending position.
Release the mouse to finish drawing the shape.
Holding down the Shift key while dragging will constrain the oval to a circle.



Cel Editor Tools Window: Rounded Rectangle Tool
This tool is used to create a rounded rectangle or square.
Select the Rounded Rectangle tool.
Click the mouse at the start location of the shape and drag to the shape's ending position.
Release the mouse to finish drawing the shape.
Holding down the Shift key while dragging will constrain rectangle to a square.



Cel Editor Tools Window: Polygon Tool
This tool is used to create a polygon shape.
Select the Polygon tool.
Click the mouse button at the start location of the polygon.
Continue clicking at points around the screen, building the desired polygon.
Double click the mouse button at the last point of the desired polygon and the two ends will 
join.
Holding down the Shift key while clicking will constrain the points to 45-degree angles.



Cel Editor Tools Window: Freehand Tool
This tool is used to create a freehand shape.
Select the Freehand tool.
Click the mouse button at the start location and draw any shape.
Release the mouse button to finish drawing the shape.



Cel Editor Tools Window: Arc Tool
This tool is used to create an oval- or circular-based arc.
Select the Arc tool.
Click and drag the oval or circle that contains the desired arc segment.
Release the mouse button.
Holding down the shift key while draging out the oval constrain's its shape to be a perfect 
circle.
Click the mouse at the desired start position of the arc and drag to the desired end position 
of the arc.
Release the mouse button.
Holding down the Shift key while dragging will constrain the arc being drawn to multiples of 
45-degrees.



Cel Editor Actor Player Window: First Cel
Click on this button to go to the first cel of the actor. This cel becomes the current cel for 
editing.



Cel Editor Actor Player Window: Previous Cel
Click on this cel to go to the previous cel of the actor. This cel becomes the current cel for 
editing.



Cel Editor Actor Player Window: Play Backwards
Click on this button to animate the actor in the backwards direction. To stop the animation 
press the Esc key or click on the button again.



Cel Editor Actor Player Window: Ping-pong Play
Click on this button to animate the actor in a back-and-forth sequence. The actor will play 
from the first cel to the last cel and then backwards from the last cel to the first cel. Press 
the Esc key to stop the animation.



Cel Editor Actor Player Window: Play Forwards
Click on this button to animate the actor in the forwards direction. To stop the animation 
press the Esc key or click on the button again.



Cel Editor Actor Player Window: Next Cel
Click on this button to go to the next cel of the actor. This cel becomes the current cel for 
editing.



Cel Editor Actor Player Window: Last Cel
Click on this button to go to the last cel of the actor. This cel becomes the current cel for 
editing.



Cel Editor Actor Player Window: Cel Scroll Bar
This scroll bar reflects the cels of the actor. The number in the box on the scroll bar (called 
the Cel Counter box) is the cel number of the current cel.
Dragging the Cel Counter box along the scroll bar allows you to scroll through the cels of 
your actor. Holding down the Ctrl key while dragging the Cel Counter box prevents the cel 
from updating until you release the mouse button.
The Cel Scroll Bar is a percentage bar; clicking in the middle of the bar takes you to the 
middle cel of the actor, clicking three quarters of the way along the scroll bar takes you to 
the cel three quarters of the way through your actor. The Cel Counter box will move to the 
spot that you clicked on the scroll bar. 



Cel Editor Menus: File Menu
The commands under the File menu allow you to create a new actor, open an existing actor, 
save an actor, reload a previously saved version of the current actor, import artwork from 
another paint program, save the contents of Cel Editor window as a bitmap file, and exit the 
Cel Editor.



Cel Editor Menus: File New
This command clears the Cel Editor window and allows you to create a new actor.



Cel Editor Menus: File Open
This commands displays the Open Actor dialog box allowing you to load in an actor from 
disk.



Cel Editor Menus: File Save
This command saves the current actor to disk. If the current actor has not been saved 
previously, you will be prompted with the standard file dialog allowing you to name and save
the actor. You will not be prompted with a file dialog in subsequent uses of the Save 
command for actors that have been saved at least once.



Cel Editor Menus: File Save As
Selecting the Save As... command will prompt you with a file dialog allowing you to save the 
current actor.
Compressed
You also have the option of turning on image compression. This will save the actor's cels in 
the actor file in an RLE compressed format which decreases load and save times as well as 
reduce the amount of disk space used.
Note
Some types of video drivers cause the images to be compressed incorrectly. If your images 
are not correct when reloaded after being saved in the compressed format, avoid using this 
option. You may want to contact the video manufacturer and request an updated driver.



Cel Editor Menus: File Create Backup
If this menu option is turned on, Animation Works Interactive will copy the original actor 
file so that it is not written over during a Save or Save As. The backup file will have the 
filename extension .BAK. When this option is on, twice as much disk space will be used, 
because two copies of the actor will be present on disk (the current version and the previous
version).



Cel Editor Menus: File Revert to Saved
This command clears the current actor from the Cel Editor window and loads the previously 
saved version of the current actor.



Cel Editor Menus: File Import
This command displays the file dialog box which allows you to load files of different graphics
formats into the Cel Editor. These file types include bitmap images (BMP or DIB), GIF files, 
and Autodesk Animator files (FLI). The file requester has a drop down list to specify the type 
of file you are importing.
For bitmap images and GIF files, the loaded image is attached to the cursor; click to place 
the image in the current cel.
For Autodesk Animator files the import operation will automatically create a new empty 
actor. Each image in the Flic file is read and converted into a separate cel of the actor. The 
resulting actor is an Animation Works Interactive compatible actor that can be edited as 
usual and used in the Movie Editor.
When you import a Flic file, a dialog box will be displayed asking you to choose a 
transparent color. You can choose black, white, or no transparent color.



Cel Editor Menus: File Save Cel As
This command allows you to save the contents of the Cel Editor window (within the 
minimum bounding rectangle) as a bitmap file (DIB).



Cel Editor Menus: File Exit All AWI Editors
This command will close down all of the Animation Works Interactive editors which are 
currently running.
If there are any changes not previously saved, you will be prompted to save them.



Cel Editor Menus: File Exit AWI Cel Editor
This command exits the Animation Works Interactive Cel Editor.
If there are any changes not previously saved, you will be prompted to save them.



Cel Editor Menus: Edit Menu
This menu contains commands which affect selected items in the Cel Editor.



Cel Editor Menus: Edit Undo
This command reverses the last change you made to the image. The menu item is grayed if 
there are no editing changes to reverse. Note that there is only one level of Undo; i.e., you 
can only undo the last editing change you made.



Cel Editor Menus: Edit Cut
This command removes the selected area from the image and places it in the Windows 
Clipboard. You can subsequently paste the image from the Clipboard to another location 
(see the Paste command below) or you can paste the image into other applications that 
access the Windows Clipboard. The menu item is grayed if no image is selected.



Cel Editor Menus: Edit Copy
This command copies the selected area into the Windows Clipboard. You can subsequently 
paste the image from the Clipboard to another location (see the Paste command below). The
menu item is grayed if no image is selected.



Cel Editor Menus: Edit Paste
This command copies the contents of the Windows Clipboard into the current cel. The menu 
item is disabled if the Windows Clipboard does not contain a bitmap image.



Cel Editor Menus: Edit Clear
This command clears the selected area from the cel. This has the effect of turning the 
selected area to the transparent color. The selection is NOT placed in the Windows 
Clipboard. The menu item is disabled if no image is selected.
The Clear command has the same effect as pressing the Delete key.



Cel Editor Menus: Selection Menu
The Selection menu allows you to modify a selected area in the Cel Editor by flipping, 
resizing, or rotating it. This menu is only enabled when a region is selected.



Cel Editor Menus: Selection Menu Flip
This command flips the current selected region either vertically or horizontally.
Horizontally
This command flips the selected area horizontally.
Vertically
This command flips the selected area vertically.
The final image is attached to the cursor; click to place the image in the current cel, and it 
then remains selected for further editing.



Cel Editor Menus: Selection Menu Size
This command changes the size of a selection on screen.
Use a selection tool to select an area of your image.
Select Selection/Size
Drag out the destination rectangle for the previous selected area to fill. You can create an 
area smaller or larger than the original selection. The final image is attached to the cursor; 
click to place the image in the current cel, and it then remains selected for further editing.



Cel Editor Menus: Selection Menu Rotate
This command allows you to rotate a selection on screen.
Selecting this command will display the Rotate Selection dialog box. Enter the number of 
degrees you wish to rotate the selection in the Angle edit box. The directions in which angles
are measured can be selected with the Counter-Clockwise or Clockwise buttons. The final 
image is attached to the cursor; click to place the image in the current cel, and it then 
remains selected for further editing.



Cel Editor Menus: GoTo Menu
The GoTo menu allows you to switch to the Movie Editor, the Background Editor, or to a 
specified cel.



Cel Editor Menus: GoTo Movie Editor
This command invokes the Movie Editor application. If the Movie Editor was already running,
it will be brought to the front. Note that the Cel Editor application will not be closed; it is 
simply overlayed by the Movie Editor window.



Cel Editor Menus: GoTo Background Editor
This command invokes the Background Editor application. If the Background Editor was 
already running, it will be brought to the front. Note that the Cel Editor application will not 
be closed; it is simply overlayed by the Background Editor window.



Cel Editor Menus: GoTo Goto Cel #
Selecting this command displays the Goto Cel Number dialog box.
Enter the cel number to jump to.
Click on the OK button.
The actor will advance to the specified cel number.



Cel Editor Menus: Actor Menu
The Actor menu displays the names of the actors that are currently loaded. The menu also 
allows you to rename or delete the current actor.



Cel Editor Menus: Actor Rename Actor
This command allows you to assign a new name to a specified actor. Selecting this 
command displays the Actor Name dialog box; enter the actor's new name in the Name edit 
box.
If you have opened other actors, their names will be displayed as menu items in the Actor 
menu. The actor currently displayed in the Cel Editor window will have a check mark beside 
the actor's name.
To display another actor in the Cel Editor window, select the actor's name in the Actor menu.



Cel Editor Menus: Actor Delete Actor
This command removes the current actor from memory.



Cel Editor Menus: Actor Palette
This command allows you to change the current color palette. You may wish to change 
palettes because the current one does not have the range of colors (hues) that you need for 
a particular actor.
Each color palette is given a name; the default palette is called System.
Selecting the Palette command displays the Select Palette dialog box.
If you select a palette in the Palette list, the available set of colors is displayed in the Palette
Preview window.
If you are satisfied with the selected palette, clicking the SELECT button will make this 
palette the current palette.



Cel Editor Menus: Cel Menu
The commands under this menu allow you to modify the cels of your actors. These 
commands include those used for registering an actor's cels to produce smooth animations, 
for adding cels to an actor, and for duplicating, rotating or sizing cels.



Cel Editor Menus: Cel Set Registration
This command allows you to set the registration point of the cels. Selecting this command 
displays the Set Registration dialog box. The registration point of the current cel is displayed
on the cel image as a cross hair.
To change the registration point, select the Set button then click on the desired location on 
the image.
After selecting the Set button, hold down Ctrl and click on the desired location to to set the 
registration point for that cel and then automatically advance to the next cel.
Press Esc to exit the automatic advance mode. This will let you use the Set Registration 
dialog box again.
Alternatively, you can use the icons in the Set Registration dialog box to set the registration 
to one of nine positions:
- top left corner, top center or top right
- left center, center, or right center
- bottom left corner, bottom center, or bottom right corner
These positions are determined with respect to the smallest rectangle that completely 
encloses the current cel image. Note that this rectangle changes from cel to cel. As you click
on an icon, the corresponding X and Y coordinates are displayed. You can enter different 
values in the X and Y fields of the Set Registration dialog box.
Click on one of the position icons in the Set Registration dialog box to set the registration 
point to that position in the current cel.
Hold down Ctrl and click on one of the position icons to automatically advance to the next 
cel after setting the registration for the current cel.
Click on the reset button to move the registration point back to its original position.
You can also choose to apply the registration to all cels, or just the current cel.



Cel Editor Menus: Cel Align Cels
This command repositions each cel image such that the registration points of all cels are 
aligned.



Cel Editor Menus: Cel Transparent Color
This command allows you to change a cel's transparent color (which by default is white). 
This color defines the see-through areas of a cel. When the cel is played in the movie, the 
transparent color areas will allow the background of the movie to show through.
Selecting the Cel/Transparent Color command displays the Select Transparent Color dialog 
box.
Click the mouse button on the color of your choice and then click on the OK button.
To choose a color that is already in use in your actor, click on the Eye Dropper tool and then 
click on the color in your actor that you want. This color will become the current transparent 
color.
The Transparent Color dialog box will be displayed.
Select one of the options on the Transparent Color dialog box (Apply to Current Cel or Apply 
to All Cels) to specify which cels are to have the chosen color be transparent.
Click on the OK button.



Cel Editor Menus: Cel Add
This command allows you to add blank cels to your actor. Selecting this command displays 
the Add Cels dialog box with the following options:
- Add Cels
Specify the number of cels to be added.
- Add After Current Cel
Adds one or more cels after the current cel.
 -Add Before Current Cel
Adds one or more cels before the current cel.



Cel Editor Menus: Cel Duplicate
This command copies the current cel a specified number of times, and inserts the copies 
after the current cel.
Select Cel/Duplicate.
Specify the number of copies to be made.
Click on OK.



Cel Editor Menus: Cel Delete
This command invokes the Delete Cels dialog box, allowing you to delete one or more cels.
Select Cel/Delete.
Specify the number of cels to be deleted.
Click on OK.



Cel Editor Menus: Cel Show Previous Cel
This command causes the previous cel to be shown while working on the current cel. This is 
important if the two cels are close in shape.



Cel Editor Menus: Cel Show Next Cel
This command causes the next cel to be shown while working on the current cel. This is 
important if the two cels are close in shape.



Cel Editor Menus: Cel Flip Cels
This command allows you to flip either the current cel or the whole actor. In the Flip Cels 
dialog box, you can specify the desired orientation (Horizontally or Vertically) and whether to
apply the flip to the current cel or all of the cels in the actor.



Cel Editor Menus: Cel Size Cels
This command changes the size of a cel to a percentage of the original size. This command 
can also be used to create a multi-cel actor from a single cel, if you specify one source cel 
and more than one destination cel.
Selecting the Size Cels command displays the Size Cels dialog box, with the following 
options:
- Source Number of Cels - this is the number of cels you wish to scale (starting from the 
current cel).
- Destination Number of Cels - this is the number of cels to result from scaling the cels 
indicated as the Source Number of Cels.
If the number of destination cels is greater than the number of source cels, new cels will be 
created while cycling through the source cel images.
If the number of source cels is greater than the number of destination cels, the extra source 
cels will be ignored.
- Starting Size - this is the size of the first cel in the destination range.
- Ending Size - this is the size of the last cel in the destination range.



Cel Editor Menus: Cel Rotate Cels
This command allows you to rotate a range of cels of the current actor to different angles.
This command can ceate new cels by specifying more destination cels than source cels. You 
can create spin effects over a range of cels.
Selecting Rotate Cels brings up a dialog in which you can specify the Number of Source Cels 
to rotate, the Number of Destination Cels, the Starting Angle and the Ending Angle.
If the number of source cels is equal to the number of destination cels, no new cels will be 
created - the cels will be rotated in place.
If the number of destination cels is greater than the number of source cels, new cels will be 
created while cycling through the source cel images.
If the number of source cels is greater than the number of destination cels, the extra source 
cels will be ignored.
The first cel of the range is always the current cel. For example, if the current cel is cel six, 
and the number of source cels is three, then the source cels are six, seven, and eight. If the 
number of destination cels is also three, then the destination cels are also six, seven, and 
eight.
The Starting Angle specifies the angle of rotation of the first cel in the destination range. 
The Ending Angle specifies the angle of rotation of the last cel in the range. Cels in-between 
are rotated incrementally between the Starting Angle and the Ending Angle.
The directions in which angles are measured can be selected with the Counter-Clockwise or 
Clockwise buttons.
The End rotation one step early option allows you to stop the rotation one step early. This is 
important if you are rotating an unchanging image through 360 (or a multiple of 360) 
degrees, in which case the last image would look the same as the first and would result in 
the animation "hesitating" if played continuously over and over again.



Cel Editor Menus: Attributes Menu
The Attributes menu allows you to alter the attributes of tools used in the Cel Editor. This 
includes text attributes, pen widths, fill patterns, drawing colors and preview speed.



Cel Editor Menus: Attributes Text
This command displays the Text Attributes window, allowing you to alter the font, font size, 
style, and color of the text you are editing. See Text/Attributes in the Movie Editor menu 
section for more information.



Cel Editor Menus: Attributes Pen
This command displays the Pen Width dialog, allowing you to change the width of the pen. 
The Brush, Line, Shape, Eraser, and Air Brush tools all use the current Pen Width setting. 
Click on the desired width in the Pen Width window to change the pen width.



Cel Editor Menus: Attributes Patterns
This command displays the Patterns window, allowing you to change the current fill pattern. 
Click on the desired pattern to change the current fill pattern.



Cel Editor Menus: Attributes Color
This command displays the Select Color dialog, from which you can select the current pen 
and fill colors.
To set the current pen color, click on the desired color in the palette with the left mouse 
button.
To set the current fill color, click on the desired color with the right mouse button. To choose 
a color that is already in use in your actor click on the Eye Dropper tool then click on the 
desired color in your actor (clicking with the left mouse button sets the pen color, and 
clicking with the right mouse button sets the fill color); this color will become the current 
pen or fill color depending on which mouse button is clicked.



Cel Editor Menus: Attributes Canvas Size
This command allows you to change the currently used canvas size.
The canvas size determines the largest cel that can be edited, created, or displayed and is 
set to the physical screen size when the Cel Editor is started. This is useful when editing an 
actor's cel that was created too large to edit within the physical screen size (perhaps it was 
created on a different computer).



Cel Editor Menus: Attributes Preview Speed
This command allows you to specify the speed at which the cels will be previewed with the 
sequence player in the Cel Editor.



Cel Editor Menus: Window Menu
The commands under this menu determine which windows are displayed and also how they 
are displayed when the Cel Editor window is resized.



Cel Editor Menus: Window Arrange
If you have moved either the Tools window or the Sequence Player from the default position,
the Arrange command returns the windows to their default positions.



Cel Editor Menus: Window Auto Arrange
This command determines whether the Tools or the Sequence Player windows remain in 
their default positions when the Cel Editor window is resized or moved. If Auto Arrange is 
toggled on (indicated by a check mark beside the menu item) and the Cel Editor window is 
resized or moved, the Tools or Sequence Player windows will be moved to the corners of the 
Cel Editor window.
If Auto Arrange is toggled off, the windows will remain in their current positions regardless of
the new location or size of the Cel Editor window.



Cel Editor Menus: Window Player
This command toggles the Sequence Player window display on or off. A check mark beside 
the menu item indicates that the window is displayed.



Cel Editor Menus: Window Tools
This command toggles the Tools window display on or off. A check mark beside the menu 
item indicates that the window is displayed.



Cel Editor Menus: Window Status
This command toggles the Status line display on or off. A check mark beside the menu item 
indicates that the Status line is displayed.



Cel Editor Menus: Help Menu
The commands under this menu display on-line help information and copyright information 
about the program.



Cel Editor Menus: Help Index
Help/Index, will bring up a window with a list of the different subjects available for help. 
Clicking on a heading in the index will bring up more information about that topic.
Some of these topics are also listed in the Help menu itself. This allows you to jump directly 
to that topic without going through the Index. For more information on using the Help menu,
select Help/Using Help.



Cel Editor Menus: Help About Cel Editor
This command displays copyright information about the Animation Works Interactive Cel
Editor. The version number of the program is also displayed. Please have this number at 
hand when calling or writing to the Technical Support department.



Cel Editor Shortcut Keys
Miscellaneous
Screen scroll Arrow keys, Page Up,

Page Down, Home, End

Sequence Player Window
Play forward Shift+Alt+P
Play ping-pong Shift+Alt+G
Go to first cel Shift+Alt+Home, or

Shift+Alt+Up Arrow
Go to last cel Shift+Alt+End, or

Shift+Alt+Down Arrow
Go to next cel Shift+Alt+Right
Go to previous cel Shift+Alt+Left
Advance 10 cels Shift+Alt+Page Down
Rewind 10 cels Shift+Alt+Page Up
Qucik frame scroll with
player window scroll bar
(screen not updated until done) Hold down Ctrl while dragging

frame number box

Tool Window
Text Tool Shift+Ctrl+A
Select Color dialog box Double Click color indicator
Pen Width dialog box Double Click straight line,

paint brush, air brush,
pencil, or empty shape tools

Fill Pattern dialog box Double Click paint bucket or
filled shape tools

Clear Screen Double Click eraser tool
Text Edit window and
Text Attributes dialog box Double Click text tool
Constrain Key Hold Shift or

Right Mouse Button
while performing action

Constrains:
- Rectangle selection tool, rectangle tools, and rounded rectangle tools to perfect 
square
- Polygon selection tool, polygon tools, and straight line tool segments to 45 
degree steps
- Paint brush tool, pencil tool, and air brush tool to vertical or horizontal directions
- Oval tools to a perfect circle
- Arc tools to perfect circle and arc lines to 45 degree steps from centre







Background Editor Tools Window: Selection Tools
These tools are used to select images (or portions of images) in the Background Editor 
window.



Background Editor Tools Window: Lasso Selection Tool
This tool is used to select a portion of your image freehand by selecting around it.
Click on the the Lasso selection tool.
Click and drag the mouse around the area you want to select.
Once you release the mouse button, the selected area will be enclosed by a dotted line.



Background Editor Tools Window: Rectangle Selection Tool
This tool is used to select a portion of your image by dragging a rectangle around it.
Click on the the Rectangle selection tool.
Click to set one corner of the rectangle and drag to the opposite corner.
Holding the shift key while draging out the rectangle constrains its shape to that of a perfect
square.



Background Editor Tools Window: Polygon Selection Tool
This tool is used to select a portion of your image by enclosing it in a polygon.
To enclose the image in a polygon:
Click on the Polygon selection tool
Select the image.
Click the mouse button at the desired starting point on the screen.
Continue clicking the mouse button at points around the screen, building a polygon that 
encloses the image. Holding the shift key while moving from one point to the next constrains
the line joining the points to the nearest 45 degree angle.
Double click the mouse button to finish the selection.



Background Editor Tools Window: Paint Tools
The paint tools are the standard painting tools used for creating images.



Background Editor Tools Window: Eraser Tool
This tool is used for erasing areas of the image.
Click on the Eraser tool
Press and hold the mouse button, then drag the mouse over the area you want erased.
Holding the shift key while draging the eraser constrains it to moving in the horizontal and 
vertical directions.
To erase the background, double-click the Eraser tool.
To change the size of the eraser use the Pen Widths dialog.



Background Editor Tools Window: Grabber Tool
The grabber tool allows you to move the entire background's image to a different location on
the screen.
Click on the the Grabber tool.
Click and drag in the window to move the entire background.
When the background's image is being dragged the edit window will automatically scroll 
when you go past the edit window's edge.
If any portion of the image is moved and placed outside the borders of the drawing area it 
will be clipped off.



Background Editor Tools Window: Paint Brush Tool
This tool is used to paint on the screen using the current pen color and width.
Click on the Paint Brush Tool
Click and drag on the screen to draw.
Double- clicking will bring up the Pen Widths dialog.
Holding down the shift key will constrain the paint brush to moving along the x or y axis.
You can use the keyboard arrows to draw also.
You can change the size of the brush by using the Pen Width dialog.



Background Editor Tools Window: Paint Bucket Tool
This tool is used to fill an enclosed area with the current fill color and pattern.
Click on the Paint Bucket tool.
Click within the area you wish to fill.
To quickly display the Fill Pattern dialog you can double click on the Paint Bucket tool.



Background Editor Tools Window: Pencil Tool
This tool is used to draw a one-pixel thick line using the current pen color.
Click on the Pencil tool.
Click and drag to draw.
Holding down the shift key will constrain drawing to the x or y axis.
To quickly display the Pen Width dialog you can double click on the Pencil tool.



Background Editor Tools Window: Air Brush Tool
This tool is used to spray-paint an area.
Click on the Air Brush tool.
Click and drag to spray the desired area.
Holding down the shift key will constrain drawing to the x or y axis.
To quickly display the Pen Width dialog you can double click on the Air Brush tool.



Background Editor Tools Window: Zoom Tool
This tool is used to magnify an area.
Click on the Zoom tool.
Click at the spot you wish to be in the center of the magnified area.
To return to normal magnification, click on the Zoom tool again, close the Zoom preview 
window, or press the ESC key.



Background Editor Tools Window: Text Tool
This tool is used to create bitmapped text.
Clicking on the Text tool brings up a text editing box where text can be entered and edited.
To customize your text, select Attributes/Text.
A dialog box will appear allowing you to change the font, font size, style alignment, and 
color. See Text/Attributes in the Movie Editor section for a more in-depth discussion of the 
Text Attributes dialog box.
To re-size the Text Edit box, position the cursor over the borders at any of the corners of the 
box or along the edges of the box and drag it to the desired size.
To reposition the text onto your image, press the Esc key, drag the text to desired location 
and click the mouse button.
Pressing the ESC key while dragging text will abort the operation.



Background Editor Tools Window: Straight Line Tool
This tool is used to draw a straight line in the current line width and pen color.
Click on the Straight Line tool.
Click at the starting point of the line and drag the mouse to draw the line.
Holding down the Shift key while dragging will constrain the line to the nearest 45-degree 
angle.
To quickly display the Pen Width dialog you can double click on the Straight Line tool.



Background Editor Tools Window: Shape Tools
There are two sets of Shape Tools in Animation Works Interactive. The first set will draw 
the shape with the current pen color, and fill it with the current fill color. The second set will 
just draw the shape with the current pen color without filling it.
To quickly display the Pen Width dialog you can double click on any of the Empty Shape 
tools.
To quickly display the Fill Pattern dialog you can double click on any of the Filled Shape tools.



Background Editor Tools Window: Rectangle Tool
This tool is used to draw a rectangle or square.
Click on the Rectangle tool.
Click the mouse at the start location of the shape and drag to the shape's ending position.
Release the mouse to finish drawing the shape.
Holding down the Shift key while dragging will constrain the rectangle to a square.



Background Editor Tools Window: Oval Tool
This tool is used to draw an oval or circle.
Click on the Oval tool.
Click the mouse at the start location of the shape and drag to the shape's ending position.
Release the mouse to finish drawing the shape.
Holding down the Shift key while dragging will constrain the oval to a circle.



Background Editor Tools Window: Rounded Rectangle Tool
This tool is used to create a rounded rectangle or square.
Click on the Rounded Rectangle Tool
Click the mouse at the start location of the shape and drag to the shape's ending position.
Release the mouse to finish drawing the shape.
Holding down the Shift key while dragging will constrain rectangle to a square.



Background Editor Tools Window: Polygon Tool
This tool is used to create a polygon shape.
Click on the Polygon tool.
Click the mouse button at the start location of the polygon.
Continue clicking at points around the screen, building the desired polygon.
Double click the mouse button at the last point of the desired polygon.
Holding down the Shift key while clicking will constrain the points to 45-degree angles.



Background Editor Tools Window: Freehand Tool
This tool is used to create a freehand shape.
Click on the Freehand tool.
Click the mouse button at the start location and draw any shape.
Release the mouse button to finish drawing the shape.



Background Editor Tools Window: Arc Tool
This tool is used to create an oval- or circular-based arc.
Click on the Arc tool.
Click and drag the oval or circle that contains the desired arc segment.
Holding the shift key while draging the oval constrains its shape to be that of a perfect 
circle.
Release the mouse button.
Click the mouse at the desired start position of the arc and drag to the desired end position 
of the arc.
Holding the shift key while picking the starting or ending positions of the arc will constrain 
their positions to 45 degree angles.
Release the mouse button.



Background Editor Menus: File Menu
The commands under the File menu allow you to create a new background, open an existing
background, save a background, reload a previously saved version of the current 
background, import artwork from another paint program, save the contents of the 
Background Editor window as a bitmap file, and exit the Background Editor.



Background Editor Menus: File New
This command clears the Background Editor window and allows you to create a new 
background.



Background Editor Menus: File Open
This commands displays the Open Background dialog box allowing you to load in a 
background from disk.



Background Editor Menus: File Import
This command allows you to load graphics stored in other formats such as GIF. When you 
select this command the Import File dialog box will be displayed. Use the drop down list to 
select the file format you wish to import. Double click the file name to load that file.



Background Editor Menus: File Save
This command saves the current background to disk. If the current background has not 
previously been saved, you will be prompted with the standard file dialog allowing you to 
name and save the background.You will not be prompted with a file dialog in subsequent 
uses of the Save command for backgrounds that have been saved at least once.



Background Editor Menus: File Save As
Selecting the Save As... command will prompt you with a file dialog allowing you to save the 
current background.
Compressed
You also have the option of turning on image compression. This will save the background 
files in an RLE compressed format which decreases load and save times as well as reduce 
the amount of disk space used.
Note
Some types of video drivers cause the images to be compressed incorrectly. If your images 
are not correct when reloaded after being saved in the compressed format, avoid using this 
option. You may want to contact the video manufacturer and request an updated driver.



Background Editor Menus: File Create Backup
If this menu option is turned on, Animation Works Interactive will copy the original 
background file so that it is not written over during a Save or Save As. The backup file will 
have the filename extension .BAK. When this option is on, twice as much disk space will be 
used, because two copies of the background will be present on disk (the current version and
the previous version).



Background Editor Menus: File Revert to Saved
This command clears the current background from the Background Editor window and loads 
the previously saved version of the current background.



Background Editor Menus: File Exit All AWI Editors
This command will close down all of the Animation Works Interactive editors which are 
currently running.
If there are any changes not previously saved, you will be prompted to save them.



Background Editor Menus: File Exit AWI Background Editor
This command exits the Animation Works Interactive Background Editor.
If there are any changes not previously saved, you will be prompted to save them.



Background Editor Menus: Edit Menu
The Edit menu affects parts of the background which have been selected with a Selection 
tool.



Background Editor Menus: Edit Undo
This command reverses the last change you made to the image. The menu item is grayed if 
there are no editing changes to reverse. Note that there is only one level of Undo; i.e., you 
can only undo the last editing change you made.



Background Editor Menus: Edit Cut
This command removes the selected area from the image and places it in the Windows 
Clipboard. You can subsequently paste the image from the Clipboard to another location 
(see the Paste command below). The menu item is grayed if no image is selected.



Background Editor Menus: Edit Copy
This command copies the selected area into the Windows Clipboard. You can subsequently 
paste the image from the Clipboard to another location (see the Paste command below). The
menu item is grayed if no image is selected.



Background Editor Menus: Edit Paste
This command copies the contents of the Windows Clipboard into the current background. 
The menu item is disabled if the Windows Clipboard does not contain a bitmap image.



Background Editor Menus: Edit Clear
This command clears the selected area from the background. This has the effect of turning 
the selected area to the background color. The selection is NOT placed in the Windows 
Clipboard. The menu item is disabled if no image is selected.
The Clear command has the same effect as pressing the Delete key.



Background Editor Menus: Selection Menu
The Selection menu allows you to flip, resize or rotate selected areas of the background. 
This menu is only enabled when a region is selected.



Background Editor Menus: Selection Menu Flip
This command flips the current selected region either vertically or horizontally.
Horizontally
This command flips the selected area horizontally.
Vertically
This command flips the selected area vertically.
The final image is attached to the cursor; click to place the image in the current cel, and it 
then remains selected for further editing.



Background Editor Menus: Selection Menu Size
This command changes the size of a selection on screen.
Use a selection tool to select an area of your image.
Select Selection/Size
Drag out the destination rectangle for the previous selected area to fill. You can create an 
area smaller or larger than the original selection. The final image is attached to the cursor; 
click to place the image in the current cel, and it then remains selected for further editing.



Background Editor Menus: Selection Menu Rotate
This command allows you to rotate a selection on screen.
Selecting this command will display the Rotate Selection dialog box. Enter the number of 
degrees you wish to rotate the selection in the Angle edit box. The directions in which angles
are measured can be selected with the Counter-Clockwise or Clockwise buttons. The final 
image is attached to the cursor; click to place the image in the current cel, and it then 
remains selected for further editing.



Background Editor Menus: GoTo Menu
The GoTo menu allows you to switch to the Movie Editor or the Cel Editor.



Background Editor Menus: GoTo Movie Editor
This command invokes the Movie Editor application. If the Movie Editor was already running,
it will be brought to the front. Note that the Background Editor application will not be closed;
it is simply overlayed by the Movie Editor window.



Background Editor Menus: GoTo Cel Editor
This command invokes the Cel Editor application. If the Cel Editor was already running, it will
be brought to the front. Note that the Background Editor application will not be closed; it is 
simply overlayed by the Cel Editor window.



Background Editor Menus: Background Menu
The Background menu displays the names of the backgrounds that are currently loaded. The
menu also allows you to rename or delete the current background, change its palette, or fill 
it with a color gradient.
If you have opened other backgrounds, their names will be displayed as menu items in the 
Background menu. The background currently displayed in the Background Editor window will
have a check mark beside the background's name.
To display another background in the Background Editor window, select the background's 
name in the Background menu.



Background Editor Menus: Background Rename 
Background
This command allows you to assign a new name to a specified background. Selecting this 
command displays the Background Name dialog box; enter the background's new name in 
the Name edit box.



Background Editor Menus: Background Delete Background
This command removes the current background from memory.



Background Editor Menus: Background Background Size
This command displays the Screen Settings dialog box which allows you to select the type of
graphics display and resolution for your background. 
You can alternatively set a custom screen definition by clicking on the Custom button and 
setting the number of horizontal and vertical pixels, the number of color bits per pixel, and a
choice of monochrome or color display.



Background Editor Menus: Background Gradient
Gradients are a way to add a full screen transition from one color to another. The palette 
displayed in the Gradient window is always the current palette.
Double-click on a color in the color palette to add colors to your gradient.
You can repeat the above step more than once to add different colors to your gradient. The 
preview box in the upper left corner of the window displays the current gradient.
Click on the line on the Direction dial to set the direction for the gradient. Hold down the 
Shift key to constrain the movement of the line on the dial to 45-degree angles.
Click on Remove All to clear the gradient range.
Click on Remove Color to remove the selected color, which is selected by clicking on the 
color in the selected color list.
Click on Dither Colors to use a dither pattern to blend between adjacent colors in the 
gradient. This is effective for eliminating the sharp edges between colors that lead to 
banding.
Click on Blend Colors if you want to use intermediate colors to blend between adjacent 
colors in the gradient. Blend Colors is most effective when working in 256 colors.
With smaller palettes, it may yield unexpected results.
Gradients created in the Movie Editor (and not edited in the Background Editor) are saved as
structures, and not as bitmaps. This means that they require only a fraction of the disk 
space normally needed to save a bitmap. Once you have edited the gradient in the 
Background Editor, the gradient is converted from a structure to a bitmap and will take 
significantly more disk space when saved.



Background Editor Menus: Background Palette
This command allows you to change the current color palette. You may wish to change 
palettes because the current one does not have the range of colors (hues) that you need for 
a particular background.
Each palette is given a name; the default palette is called System.
Selecting the Palette command displays the Select Palette dialog box.
If you select a palette in the Palette list, the available set of colors is displayed in the Palette
Preview window.
If you are satisfied with the selected palette, clicking the SELECT button will make that 
palette the current one.



Background Editor Menus: Attributes Menu
The Attributes menu allows you to alter the text attributes, pen width, fill patterns and 
drawing color used by tools in the Background Editor.



Background Editor Menus: Attributes Text
This command displays the Text Attributes window, allowing you to alter the font, font size, 
style, and color of the text you are editing. See Text/Attributes in the Movie Editor menu 
section for more information.



Background Editor Menus: Attributes Pen
This command displays the Pen Width window, allowing you to change the width of the pen. 
The Brush, Line and Shape tools all use the current Pen Width setting.



Background Editor Menus: Attributes Patterns
This command displays the Patterns window, allowing you to change the current fill pattern.



Background Editor Menus: Attributes Color
This command displays the Select Color window, allowing you to select the current pen and 
fill colors.
To set the current pen color, click on the desired color in the palette with the left mouse 
button.
To set the current fill color, click on the desired color with the right mouse button.
To set the current color to a color already in use in the background image, click once on the 
eyedropper button, then click on the desired color on screen, using the left or right mouse 
button to set the pen color or fill color respectively.



Background Editor Menus: Window Menu
The commands under this menu determine which windows are displayed and also how they 
are displayed when the Background Editor window is resized.



Background Editor Menus: Window Arrange
If you have moved the Tools window from its default position, the Arrange command returns 
it to its default position.



Background Editor Menus: Window Auto Arrange
This command determines whether the Tools window remains in its default position when 
the Background Editor window is resized or moved. If Auto Arrange is toggled on (indicated 
by a check mark beside the menu item) and the Background Editor window is resized or 
moved, the Tool window will be moved to a corner of the Background Editor window.
If Auto Arrange is toggled off, the Tools window will remain in its current position regardless 
of the new location or size of the Background Editor window.



Background Editor Menus: Window Tools
This command toggles the Tools window display on or off. A check mark beside the menu 
item indicates that the window is displayed.



Background Editor Menus: Window Status
This command toggles the Status line display on or off. A check mark beside the menu item 
indicates that the Status line is displayed.



Background Editor Menus: Help Menu
The commands under this menu display on-line help information and copyright information 
about the Background Editor.



Background Editor Menus: Help Index
Help/Index, will bring up a window with a list of the different subjects available for help. 
Clicking on a heading in the index will bring up more information about that topic.
Some of these topics are also listed in the Help menu itself. This allows you to jump directly 
to that topic without going through the Index. For more information on using the Help menu,
select Help/Using Help.



Background Editor Menus: Help About Background Editor
This command displays copyright information about the Animation Works Interactive 
Background Editor. The version number of the program is also displayed. Please have this 
number at hand when calling or writing to the Technical Support department.



Background Editor Shortcut Keys
Miscellaneous
Screen scroll Arrow keys, Page Up,

Page Down, Home, End

Tool Window
Text Tool Shift+Ctrl+A
Select Color dialog box Double Click color indicator
Pen Width dialog box Double Click straight line,

paint brush, air brush,
pencil, or empty shape tools

Fill Pattern dialog box Double Click paint bucket or
filled shape tools

Clear Screen Double Click eraser tool
Text Edit window and
Text Attributes dialog box Double Click text tool
Constrain Key Hold Shift or

Right Mouse Button
while performing action

Constrains:
- Rectangle selection tool, rectangle tools, and rounded rectangle tools to perfect 
square
- Polygon selection tool, polygon tools, and straight line tool segments to 45 
degree steps
- Paint brush tool, pencil tool, and air brush tool to vertical or horizontal directions
- Oval tools to a perfect circle
- Arc tools to perfect circle and arc lines to 45 degree steps from centre




